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CHAPTER 1

Introduction

�Migrating a Two-Tier Application to Azure Using 
Different Architectures and DevOps Best Practices
�Setting the Scene
You are part of an organization that is running an e-commerce platform application, at 

present using Windows Server on-premises infrastructure, based on a virtual Windows 

Server 2012 R2 web server running Internet Information Services (IIS) and a second 

Windows Server 2012 R2 virtual machine (VM) running Microsoft SQL Server 2014 

database services.

The business has approved a migration of this business-critical workload to Azure, 

and you are nominated as the cloud solution engineer for this project. No decision has 

been made yet on what the final architecture should or will look like. Your first task is 

building different Proof of Concepts in your Azure environment, to test out the different 

architectures available today, to host your application workload:

–– Infrastructure as a Service (IAAS), using Azure Virtual Machines

–– Platform as a Service (PAAS), using Azure Web Apps and Azure SQL

–– Containers as a Service (CAAS), using Azure Container Instance (ACI) 

and Azure Kubernetes Service (AKS)

At the same time, your CIO wants to make use of this project to switch from a more 

traditional mode of operations, with barriers between IT sysadmin teams and developer 

teams, to a “DevOps” way of working. Therefore, you are tasked to explore Azure DevOps 

and determine where CI/CD pipelines, together with other capabilities from Azure DevOps, 

can assist in optimizing the deployment as well as optimizing the running operations of this 

e-commerce platform, especially when deploying updates to the application.

https://doi.org/10.1007/978-1-4842-6437-9_1#DOI
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As you are new to the continuous changes in Azure, you want to make sure this 

process goes as smooth as possible, starting from the assessment over migration to 

performing day-to-day operations.

�Abstract and Learning Objectives
This book enables anyone to learn, understand, and build a Proof of Concept, by 

performing a platform migration of a two-tiered application workload to Azure public 

cloud, leveraging on different Azure Infrastructure as a Service, Azure Platform as a 

Service (PAAS), and Azure container offerings like Azure Container Instance (ACI) and 

Azure Kubernetes Service (AKS).

The focus of the book is having a true hands-on lab experience, by going through the 

following exercises and tasks:

•	 Deploying your “lab virtual machine”

•	 Deploying a two-tier Azure Virtual Machine (web server and SQL 

database server) using Infrastructure as Code (IAC) concepts with 

ARM (Azure Resource Manager) template automation in Visual 

Studio 2019

•	 Performing a proper assessment of the as-is WebVM and  

SQLVM infrastructure using Microsoft assessment tools

•	 Migrating a SQL Server 2014 database to Azure SQL PaaS  

(lift and shift)

•	 Migrating a .NET Core web application to Azure Web Apps  

(lift and shift)

•	 Containerizing a .NET Core web application using Docker and 

pushing to Azure Container Registry (ACR)

•	 Running a containerized application in Azure Container  

Instance (ACI) and Azure Web App for Containers

•	 Running a containerized application in Azure Kubernetes  

Service (AKS)
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•	 Deploying Azure DevOps and building a CI/CD pipeline for the 

sample e-commerce application

•	 Managing and monitoring Azure Kubernetes Service (AKS) and other 

Azure Monitor capabilities

Starting from an (optional but highly recommended for consistency) ARM template–

based deployment of a lab virtual machine, readers get introduced to the basics of 

automating Azure resource deployments using Visual Studio and Azure Resource 

Manager (ARM) templates, together with additional Infrastructure as Code concepts like 

Custom Script Extension and PowerShell Desired State Configuration (DSC).

Next, readers learn about the importance of performing proper assessments and 

what tools Microsoft offers to help in this migration preparation phase. Once the 

application has been deployed on Azure Virtual Machines, readers learn about Microsoft 

SQL Server database migration to Azure SQL PAAS, as well as deploying and migrating 

web applications to Azure Web Apps.

After these foundational platform components, the following chapters will totally 

focus on the core concepts and advantages of using containers for running business 

workloads, based on Docker, Azure Container Registry (ACR), Azure Container Instance 

(ACI), and Web App for Containers, as well as how to enable container orchestration and 

cloud scale using Azure Kubernetes Service (AKS).

In the last part of the book, readers get introduced to Azure DevOps, the Microsoft 

application lifecycle environment, helping in building a CI/CD pipeline to publish 

workloads using the DevOps principles and concepts, showing the integration with 

the rest of the already-touched-on Azure services like Azure Web Apps and Azure 

Kubernetes Service (AKS), closing the exercises with a chapter on Azure monitoring and 

operations and what tools Azure has available to assist your IT teams in this challenge.

Note T he Proof of Concept lab scenario is built in such a way that each lab 
exercise is building on top of the previous lab exercise in sequence. Given the 
dependencies across different labs, make sure you finish each lab exercise 
successfully, before continuing on to the next lab.
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�Technical Requirements
Before being able to perform the hands-on tasks in this book, make sure you meet each 

of the technical requirements:

–– Azure subscription with full administrative permissions

–– Naming conventions

�Azure Subscription
Make sure you have (full administrative) access to an Azure subscription, allowing you 

to deploy the different Azure resources being used throughout the exercises. You can use 

an Azure free or trial subscription or use any paid subscription.

Signing up for a free/trial subscription can be done from here: https://signup.

azure.com/signup?offer=ms-azr-0044p&appId=102&l=en-gb&correlationId=37037FE

60CF76B40251371B40DDF6AB9

 

If you go through all exercises, estimate an average consumption of 20–30 USD, 

assuming you shut down or delete the resources that are no longer in use or required.

Chapter 1  Introduction

https://signup.azure.com/signup?offer=ms-azr-0044p&appId=102&l=en-gb&correlationId=37037FE60CF76B40251371B40DDF6AB9
https://signup.azure.com/signup?offer=ms-azr-0044p&appId=102&l=en-gb&correlationId=37037FE60CF76B40251371B40DDF6AB9
https://signup.azure.com/signup?offer=ms-azr-0044p&appId=102&l=en-gb&correlationId=37037FE60CF76B40251371B40DDF6AB9


5

�Naming Conventions

Important  Most Azure resources require unique names. Throughout the 
lab steps, we will identify the naming convention for the given resources as 
“[SUFFIX]” as part of resource names. You should replace this with a unique 
string, e.g., your own initials, guaranteeing those resources get uniquely named 
and not blocking a successful deployment.

�Other Requirements
Readers need a local client admin machine, running a recent Operating System, allowing 

them to

–– Browse to https://portal.azure.com from a recent browser.

–– Establish a secured Remote Desktop (RDP) session to a lab jumpVM 

running Windows Server 2019.

�Alternative Approach
Where the lab scenario assumes all exercises will be performed from within a lab 

jumpVM (see Chapter 2 on how to get started with this deployment), readers could also 

execute (most, if not all) steps from their local client machine, if that is what they prefer.

The following tools are being used throughout the lab exercises:

–– Visual Studio 2019 community edition (updated to latest version)

–– Docker for Windows (updated to latest version)

–– Azure CLI 2.0 (updated to latest version)

–– Kubernetes CLI (updated to latest version)

–– SimplCommerce Open Source e-commerce platform example 

(http://www.simplcommerce.com)

Chapter 1  Introduction
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Note  Make sure you have these tools installed prior to the workshop if you are 
not using the lab jumpVM. You should also have full administrator rights on your 
machine to execute certain steps in using these tools.

�Final Remarks
Due to the continuously evolving nature of Azure, Azure services, the Azure Portal, 

and other tools we will be using for the exercises, it might be that some screenshots or 

wordings do not match what you will see on your end. We apologize for this already, 

although there isn’t much we can do about it. If the differences are too many, it would be 

almost impossible to execute the exercises. Please have a look at our GitHub repository 

http://www.apress.com/source-code for any updates and errata.

We hope you enjoy the different exercises, learn from them, and find them useful 

in your day-to-day job or journey in which you explore Azure capabilities. Do not 

hesitate reaching out at peter@pdtit.be or @pdtit (Twitter) in case you have any 

questions. We are here to help you making this a successful learning path.
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CHAPTER 2

Prerequisite Lab: 
Deploying Your Lab 
Virtual Machine

�Prerequisite lab: Preparing your (Azure) 
environment
�What You Will Learn
In this first lab, you prepare the baseline for executing all hands-on lab exercises:

–– Log on to your Azure subscription.

–– Deploy the lab jumpVM within your Azure subscription.

–– Download the required source files from GitHub to the lab jumpVM.

�Time Estimate
This lab is estimated to take 45 min, assuming your Azure subscription is already 

available.

https://doi.org/10.1007/978-1-4842-6437-9_2#DOI
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�Task 1: Deploying the lab jumpVM virtual machine using 
Azure Portal template deployment
In this task, you start deploying the “lab jumpVM” virtual machine in your Azure 

environment. This machine becomes the starting point for all future exercises, as it 

has most required tools already installed. The deployment is based on an ARM (Azure 

Resource Manager) template in a publicly shared GitHub repository.

	 1.	 Once you are logged on to your Azure subscription, select Create 
a Resource.

	 2.	 In the Search Azure Marketplace field, type “template 

deployment”.

Chapter 2  Prerequisite Lab: Deploying Your Lab Virtual Machine



9

	 3.	 And select Template deployment (deploy using custom 
templates) from the list of Marketplace results, followed by 

clicking the Create button.

	 4.	 This opens the Custom deployment blade. Here, select “Build 

your own template in the editor.”
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	 5.	 First, from a second tab in your browser window, go to the 

following URL on GitHub, browsing to the source files repository 

for this lab, specifically the JumpVM folder:

http://www.apress.com/source-code.
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	 6.	 Select the azuredeploy.json object in there. This exposes the 

details of the actual JSON deployment file.
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	 7.	 Click the Raw button, to open the actual file in your browser.

	 8.	 Your browser should show the content as follows:
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	 9.	 Here, select all lines in the JSON file, and copy its content to the 

clipboard.

	 10.	 Go back to the Azure Portal. From “the edit template” blade, 

remove the first six lines of code you see in there, and paste in 
the JSON content from the clipboard.

	 11.	 “The edit template” blade should recognize the content of the 

JSON file, showing the details in the JSON Outline on the left.

	 12.	 Click the Save button.
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	 13.	 This redirects you back to the Custom deployment blade, from 

where you will execute the actual template deployment, filling in 

the required fields as follows:

–– Subscription: Your Azure subscription

–– Resource group: Create New/[SUFFIX]-JumpVMRG

–– Location: Your closest by Azure region

–– Admin Username: labadmin (this information is picked up from the ARM 

template; although you could change this, we recommend you to not do so 

for consistency with the lab guide instructions and avoiding any errors 

during later deployment steps)

–– Admin Password: L@BadminPa55w.rd (this information is picked up from 

the ARM template; although you could change this, we recommend you to 

not do so for consistency with the lab guide instructions and avoiding any 

errors during later deployment steps)
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	 14.	 When all fields have been completed, scroll down in the blade. 

Under the Terms and Conditions section, check “I agree to the 
terms and conditions stated above,” and click the Purchase 

button.

	 15.	 This sets off the actual Azure resource deployment process. 

From the Notifications area, you can get update information 

about the deployment.
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	 16.	 If you click “Deployment in progress…,” you will get redirected to 

the Microsoft.Template Overview blade, showing you the details of 

each Azure resource getting deployed.

	 17.	 Wait for the deployment to complete successfully. Note this could 
take up to 25–30 minutes, because of the custom scripts we 
run during the installation process, which you can see from this 

detailed view or from the Notifications area.

	 18.	 From the notification message, click “Go to resource group.” (If 

you already closed the notification message, from the Azure Portal 

navigation menu to the left, select Resource groups.)
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	 19.	 Click the jumpvm Azure Virtual Machine resource. This 

redirects you to the detailed blade for the jumpvm resource. Here, 

click the Connect button.

Note B ecause the VM is linked to a “basic” public IP address resource, all 
incoming TCPIP traffic is allowed. Therefore, incoming RDP is just working. In a 
real-life scenario, this VM would be configured with Network Security Group (NSG) 
rules, only allowing specific traffic.

	 20.	 From the Connect to virtual machine blade, notice the public 
IP address and port 3389. This allows you to establish an RDP 

session to the Azure VM. Do this by clicking the Download RDP 
File button.

Chapter 2  Prerequisite Lab: Deploying Your Lab Virtual Machine



18

(Note: If your local network blocks direct RDP to Azure VMs, 

consider having a look at Azure Bastion, an Azure service 

performing HTML5 browser-based routing to RDP or SSH-

enabled machines. Specifically for this JumpVM, we offer an ARM 

template in the same GitHub repo as the JumpVM: https://

github.com/pdtit/2TierAzureMigration/blob/master/JumpVM/

bastion-template.json.

	 21.	 Open the downloaded RDP file; You are prompted for your 

credentials in the next step, provide the VM administrator name 
(labadmin) and its password (L@BadminPa55w.rd), which are 
the default.
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	 22.	 From the appearing popup window, set the flag to “Don’t ask me 

again for connections to this computer.”

	 23.	 Your Remote Desktop session to this Azure VM gets established.

	 24.	 A popup message will appear, asking if you want to allow network 

discovery; close this popup using the No button.
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	 25.	 Next, “Server Manager” will open automatically. Close this for 

now. You will arrive at the desktop.

�Task 2: Cloning the setup scripts from GitHub
In this task, you run Git command-line steps, to clone the necessary source files from 

GitHub to your lab jumpVM.

	 1.	 From the lab jumpVM, open a command prompt.

	 2.	 Run the following command:

git clone http://www.apress.com/source-code
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	 3.	 This downloads all lab-related source files to the C drive of the 

JumpVM, into the 2TierAzureMigration folder.

�Summary
This completes this prerequisite task, in which you deployed a Windows 2019 Azure VM 

as Jump server, by using Azure Resource Manager template–based deployment.

You will use this JumpVM for all future exercises requiring “tools” like Visual Studio, 

Docker, SQL Server Management Studio, and so on.
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CHAPTER 3

Lab 1: Deploying an Azure 
Virtual Machine Baseline 
Application Workload

�Lab 1: Deploying the baseline virtual machine 
environment using an ARM template from within 
Visual Studio 2019

�What You Will Learn
In this task, you are guided through the definition of an ARM template, which is used 

to deploy the baseline virtual machine WebVM and SQLVM topology you need in the 

next lab. After you understand the core building blocks within the template, you run the 

actual template deployment from within Visual Studio 2019.

�Time Estimate
This lab is estimated to take 60 min, assuming your Azure subscription is already 

available.

https://doi.org/10.1007/978-1-4842-6437-9_3#DOI
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�Prerequisites

Note  The assumption is this lab will be performed from within the lab jumpVM, 
unless you choose to use your own administrative workstation for this. See 
Chapter 2 for instructions on how to deploy this VM if needed.

�Task 1: Understanding the ARM template building 
blocks
The focus of this first task is becoming familiar with the baseline VM deployment for 

future labs, using ARM template building blocks. As part of Infrastructure as Code (IAC), 

ARM templates can be used to automate the deployment and configuration of Azure-

running resources. Out of this template, you deploy the following Azure resources:

–– Azure Virtual Network “AzTrainingVNET,” with two subnets

–– WebVM virtual machine running IIS on Windows Server 2012 R2:

•	 Azure resources themselves

•	 WebDSC.ps1, as part of PowerShell DSC VM Extension

•	 Customize-winVM.ps1, as part of Custom Script Extension

–– SQLVM virtual machine running SQL Server 2014 on Windows  

Server 2012 R2:

•	 Azure resources themselves

•	 SQLDSC.ps1, as part of PowerShell DSC VM Extension

•	 Customize-winVM.ps1, as part of Custom Script Extension
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	 1.	 From the lab JumpVM desktop, launch Visual Studio 2019.  
You are prompted with a Welcome popup to authenticate.
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	 2.	 Click the Sign in button, which will open the Microsoft “Sign in 

to your account” window; provide your Azure admin credentials 

here.
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	 3.	 Wait for Visual Studio 2019 to launch. Select a theme of choice for 

the layout of Visual Studio 2019.
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	 4.	 Continue to Visual Studio by clicking the “Start Visual Studio” 

button.

	 5.	 From the “Get started” window, select “Open a project or 
solution.”

	 6.	 Browse to the 2TierAzureMigration folder on the JumpVM, and 

select the WebVM-SQLVM-ARMDeploy folder. From here, select 
the AzureResourceGroup44.sln file. Click Open.

Note I f you don’t have this source files folder, see “Task 2” in Chapter 2 to get 
the files.
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	 7.	 Make yourself familiar with the different files and folders in this 

project, using the Solution Explorer view.
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	 8.	 In short, these files are doing the following:

File Purpose

Azuredeploy.json The actual ARM template deployment file, which creates 

the different Azure resources for both WebVM and SQLVM 

infrastructure.

Azuredeploy.parameters.json The ARM template parameters file.

\CustomScripts\ 

Customize-WinVM.ps1

A PowerShell script, containing specific settings that get 

applied to both VMs using PowerShell.

DSC\SQLDSC.ps1 A PowerShell script that is used to customize the installation 

and configuration of SQL Server on the SQLVM:

−  Format disks.

− I nstall SQL Server 2017 + mgmt. tools.

−  Download simplcommerce.bak from Azure Storage.

− R un SQL database restore.

DSC\WebDSC.ps1 A PowerShell script that is used to customize the installation 

and configuration of IIS web server on the WebVM:

− I nstall IIS core components + mgmt. tools.

− I nstall .NET framework 4.5.

− R un silent install of the dotnetcore modules.

Deploy-AzureResourceGroup.ps1 A PowerShell script that is used by VS2017 to run the actual 

deployment of the ARM template.

	 9.	 Select the file azuredeploy.json to open it. This will load the 

details in a separate window, showing the JSON Outline for this 

ARM template.
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Note I f the JSON Outline view is not visible, open it from the top menu. Click 
View ➤ Other Windows ➤ JSON Outline, to open the JSON viewer.

	 10.	 Read through the different files, to become familiar with the 

actual Azure resources getting deployed and the core settings 

used for this (VNET, subnets) as this will help in understanding 

the base VM landscape of our workload.

�Task 2: Running an ARM template deployment 
from Visual Studio 2019
In this task, you start deploying the “lab jumpVM” virtual machine in your Azure 

environment. This machine becomes the starting point for all future exercises, as it has 

most required tools already.
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	 1.	 From within the Solution Explorer window, select the 

AzureResourceGroup44 project, and right-click it; and from the 

context menu, select Deploy ➤ New….

	 2.	 In the appearing “Deploy to Resource Group” popup, complete 

the following settings:
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–– Subscription: Your Azure subscription

–– Resource group: Create New/[SUFFIX]-VMs – with location the one 

closest to your location

–– Deployment template: azuredeploy.json

–– Template parameters file: azuredeploy.parameters.json

	 3.	 Before clicking the Deploy button, complete some additional 

deployment settings by clicking the Edit Parameters… button.

Basically, the only required change here is providing a new unique 

DNS name for the WebPublicIPDnsName parameter:

Chapter 3  Lab 1: Deploying an Azure Virtual Machine Baseline Application Workload



34

–– WebVMName: WebVM

–– WebVMAdminUserName: labadmin

–– WebVMAdminPassword: L@BadminPa55w.rd (do not alter this 
password, as otherwise the customization script later on won’t 
work)

–– WebVMWindowsOSVersion: 2012-R2-Datacenter

–– WebPublicIPDnsName: [suffix]webvm<date> (all lowercase, no 
complex characters)

–– SQLVMName: SQLVM

–– SQLVMAdminUserName: labadmin

–– SQLVMAdminPassword: L@BadminPa55w.rd (do not alter this 
password, as otherwise the customization script later on won’t 
work)
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	 4.	 Check the “Save passwords as plain text in the parameters file.” 

(Note: This is ok in this lab environment, but not recommended in 

production deployments. If this option is not checked, you will get 

a PowerShell window appearing, asking you for this administrator 

password there.)

	 5.	 Once all settings have been completed in the Edit Parameters 

popup window, click Save. You are redirected to the “Deploy to 

Resource Group” window. Start the actual deployment by clicking 

the Deploy button.

	 6.	 The Azure resource deployment kicks off, which can be followed 

from the Visual Studio Output window. (For your info, this 
deployment takes about 15–20 min. It might be a good time for 
a break.)
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	 7.	 While the deployment from Visual Studio is still running, open 

your Internet browser, connect to http://portal.azure.com, 

and authenticate with your Azure subscription credentials. Go to 
Resource groups, and open the [SUFFIX]-VMs resource group 
(RG). Here, you can see the different resources getting created.
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	 8.	 From the Resource groups blade, Settings section, click 

Deployments.

	 9.	 This shows the actual running deployment task.

	 10.	 Click the deployment name (e.g., azuredeploy-0804-2321), 
which shows you more details about the actual deployment) 

process, including the already deployed resources.
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	 11.	 Wait for the deployment to complete successfully. This is 

noticeable from within the Visual Studio Output window or from 

within the Azure Portal Deployment blade you were in before.

Chapter 3  Lab 1: Deploying an Azure Virtual Machine Baseline Application Workload



39

	 12.	 Close Visual Studio without saving changes to the project.

To verify all went fine during the deployment of the Azure 

resources, as well as the customization and configuration using 

PowerShell Desired State Configuration, we will validate if the 

e-commerce webshop sample workload is running fine.

	 13.	 From within the Azure Portal, go to Resource groups, and select 

the resource group where you deployed the VMs ([SUFFIX]-
VMs). In here, select the WebVM virtual machine by clicking it. 

This opens the WebVM detailed blade.
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	 14.	 Notice the Public IP address of the WebVM resource. Open your 
browser and connect to this IP address. After a few seconds, the 

SimplCommerce webshop home page should become visible.
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	 15.	 Back in the Azure Portal, from your WebVM blade (within the 

Azure Portal, go to Resource groups, and select the resource 

group where you deployed the VMs ([SUFFIX]-VMs). In here, 

select the WebVM virtual machine by clicking it. This opens the 
WebVM detailed blade), select Overview ➤ Connect.

	 16.	 Click the Connect button, to open the Remote Dekstop session to 

this WebVM virtual machine.

	 17.	 Here, log on with the credentials from the ARM template 

(labadmin, L@BadminPa55w.rd) unless you changed those before 

the deployment in Visual Studio.

	 18.	 From within the WebVM RDP session’s Start menu, search for 

“IIS,” which resolves Internet Information Services Manager.

Chapter 3  Lab 1: Deploying an Azure Virtual Machine Baseline Application Workload



43

	 19.	 Launch Internet Information Services Manager.

	 20.	 This deployment has a Default Web Site configured.

Close the Internet browser session on the WebVM.

	 21.	 Still from within the WebVM RDP session, start a new RDP 

session to the SQLVM (this needs to happen from within the 

WebVM, as the SQLVM has no public IP address attached to its 

NIC, thus not reachable from the Internet directly), by clicking the 

Start button and typing “mstsc”; this finds the Microsoft Remote 

Desktop Connection. Launch it.
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	 22.	 Enter “sqlvm” as computer name; next, click the Connect button.

	 23.	 Provide the following credentials to authenticate:

User: labadmin

Password: L@BadminPa55w.rd
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	 24.	 And click OK to continue.

	 25.	 When prompted with “The identity of the remote computer 
cannot be verified” error, select “Don’t ask me again for 
connections to this computer.”
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	 26.	 Click Yes to open the RDP session. Wait for the desktop of the 

SQLVM to load completely.

	 27.	 From the Start menu of the SQLVM, search for “SQL 

management,” which will resolve a list of keywords and 

applications. Here, select Microsoft SQL Server Management 
Studio 18.

	 28.	 From SQL Server Management Studio, the “Connect to Server” 

popup opens. Provide the following information:

–– Server type: Database Engine

–– Server name: SQLVM

–– Authentication: SQL Server Authentication
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	 29.	 Click Connect to open the SQL Server connection.

	 30.	 Validate the SimplCommerce database object is available under 

the Databases section of the server.
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	 31.	 Open the SimplCommerce database, by clicking the “+” in front 

of the name; browse to Tables and click the “+” again here. This 

opens a list of all tables within this database. Here, browse to dbo.
Catalog_Product and select it.

	 32.	 Next, right-click this table, to open the context menu. Here, select 
“Edit Top 200 Rows.”
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	 33.	 This shows a list of products in our sample e-commerce 

application.

	 34.	 This confirms the deployment of the SQL Server VM was 

successful.

This completes the task.

�Summary
In this lab, you started with deploying an ARM template from within the Azure Portal, 

deploying a lab jumpVM virtual machine in Azure.
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In the next task, you learned how to deploy a more complex Azure environment, 

again using an ARM template, where deployment was executed from within Visual 

Studio 2017/2019, using ARM templates to deploy Azure resources, as well as relying on 

Azure VM PowerShell DSC and Custom Script Extensions to fine-tune the configuration 

of the WebVM and SQLVM virtual machines.
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CHAPTER 4

Lab 2: Performing 
Assessment of Your  
As-Is Situation

�Lab 2: Performing assessment of your as-is 
situation
�What You Will Learn
In this second lab, you focus on performing the necessary assessment phase in your 

simulated “on-premises” application landscape, by using Microsoft assessment tools:

–– Microsoft Data Migration Assistant (DMA)

–– Azure App Service Migration Assistant

�Time Estimate
This lab is estimated to take 30 min, assuming your Azure subscription is already 

available and you successfully completed Lab 1, in which you deployed the baseline 

setup with the WebVM and SQLVM.

�Prerequisites
Make sure you completed the ARM scenario deployment from Lab 1 before starting this 

exercise, as it is continuing on the infrastructure deployed out of that lab.
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�Task 1: Running a SQL Server assessment using Data 
Migration Assistant
In short, you will perform the following tasks:

	 1.	 Install the Azure Data Migration Assistant on the WebVM.

	 2.	 Perform an assessment of the to-be-migrated database.

In this task, you download and install the Azure Data Migration Assistant.

	 1.	 Connect to the WebVM virtual machine using RDP, by selecting 

the WebVM from the Virtual machines section in the Azure Portal 

followed by selecting Connect.
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	 2.	 In the Connect blade, click Download RDP File. Once 

downloaded, open the file. This will start the Remote Desktop, 

asking for credentials. Here, select “Use a different account” and 

provide the following credentials:

User account: labadmin

Password: L@BadminPa55w.rd
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	 3.	 When you are prompted for a certificate security warning, select 

Don’t ask me again… and click Yes to continue.

	 4.	 Once logged on to the desktop of the WebVM, open the browser, 

and search for Azure Data Migration Assistant download, or 

connect directly to the following URL: www.microsoft.com/en-

us/download/details.aspx?id=53595.
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	 5.	 Once the download is complete, launch the 

DataMigrationAssistant.msi. Click Next to continue.
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	 6.	 Accept the license terms agreement, click Next, and confirm 

by clicking the Install button. Wait for the install to complete 

successfully.
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	 7.	 To open the DMA tool, select “Launch Microsoft Data Migration 
Assistant.”

	 8.	 From Data Migration Assistant, select the + on the side to launch 
a new “Assessment” scenario.
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	 9.	 We start by running an assessment. Complete the wizard with the 

following parameters:

–– Project type: Assessment

–– Project name: assess

–– Assessment type: Database Engine

–– Source server type: SQL Server

–– Target server type: Azure SQL Database

And confirm these options by clicking “Create.”
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	 10.	 This launches the Data Migration Assistant selection window. 

Here, click Next to continue.

	 11.	 We now need to connect to our source SQL Server. Therefore, 

provide the following information in the wizard:

–– Server name: sqlvm

–– Authentication type: Windows Authentication

–– Username: labadmin

–– Password: L@BadminPa55w.rd

Also flag both options “Encrypt connection” and “Trust server 
certificate.”
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	 12.	 Click Connect to continue. This brings up the sources list.

	 13.	 Select SimplCommerce as source database, and select Add, to 

add this database to the list.
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	 14.	 Next, click the “Start Assessment” button. This runs the 

assessment and should take a few minutes to complete. Take note 

of the several recommendations under Unsupported features 

and Partially supported features.
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	 15.	 Once you are familiar with the reported features, you can close 

Data Migration Assistant.

This completes the task in which you deployed and ran Data Migration Assistant to 

validate compatibility of your source SQL Server database with Azure SQL target.

In a next lab, you will reuse this tool to perform the actual database migration.

�Task 2: Running a web server assessment using Azure 
App Service Migration Assistant
In short, you will perform the following tasks:

	 1.	 Install the Azure App Service Migration Assistant on the WebVM.

	 2.	 Perform an assessment of the to-be-migrated web application.

In this task, you download and install the Azure App Service Migration Assistant. We 

are using the WebVM directly in this lab, but you can run this from any Windows Server 

in the same network as the WebVM virtual machine, meaning you don’t have to install it 

on the web server VM itself.

	 1.	 Connect to the WebVM virtual machine using RDP, by selecting 

the WebVM from the Virtual machines section in the Azure Portal 

followed by selecting Connect and authenticating with labadmin 

and L@BadminPa55w.rd as credentials.

	 2.	 From within the WebVM, open an Internet browser, and connect 

to the following URL to download the latest version of the Azure 

App Service Migration Assistant:

https://appmigration.microsoft.com/
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	 3.	 Click the Download option, to get redirected to the download 

page. Here, continue with clicking the Download button.
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	 4.	 Once downloaded, launch the AppServiceMigrationAssistant.
msi, which will configure a shortcut on the desktop.

	 5.	 Launch the AppServiceMigrationAssistant. This brings up a five-

step scenario. Select Step 1 “Choose a Site”; here, notice it has 

found one site, “Default Web Site.”
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	 6.	 Select “Default Web Site” and click Next to continue.

	 7.	 This results in a detailed assessment report of the web 

application. Browse through this report to become familiar with 

the gathered information.
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	 8.	 Notice we have no errors nor warnings.

	 9.	 Leave this web app migration tool open for now, as you will 
reuse it in a following chapter to perform the actual web app 
migration. If you close it, you will need to run part of the 
assessment again later.

This completes the task in which you installed and ran the App Service Migration 

Assistant tool, to identify compatibility and supportability issues of your existing web 

application workload, when being migrated to Azure Web Apps.

�Summary
In this lab, you deployed the Data Migration Assistant as well as the App Service 

Migration Assistant, to validate your existing e-commerce application environment, 

being compatible with Azure Platform as a Service, as part of the assessment phase of 

your migration project.

In the next labs, you will reuse these tools to perform an actual migration of the 

SQL Server database to Azure SQL, as well as migrating the web application to Azure 

Web Apps.
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CHAPTER 5

Lab 3: Deploying an 
Azure SQL Database and 
Migrating from SQLVM

�Lab 3: Deploying an Azure SQL database 
and migrating from SQLVM
�What You Will Learn
In this lab, you perform a migration from a SQL 2014 database running on the SQLVM to 

SQL Azure PaaS, using the SQL Data Migration Assistant (DMA), following these steps:

–– Deploy a new Azure SQL Server instance.

–– Authenticate to SSMS on the SQLVM virtual machine.

–– Run the database migration wizard from within DMA.

–– Verify the successful migration of the SQL database from the  

VM to Azure.

–– Update the connection strings on the WebVM web application to 

point to the SQL Azure database instead of the on-premises one  

on SQLVM.

–– Optional: Migrate the database using SQL Server  

Management Studio.

https://doi.org/10.1007/978-1-4842-6437-9_5#DOI
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�Time Estimate
This lab is estimated to take 60 min, assuming your Azure subscription is already 

available.

�Prerequisites
Make sure you completed Lab 1 and Lab 2 before starting this lab scenario, as it is 

building up on those.

�Scenario Diagram

 

�Task 1: Deploying a new Azure SQL Server instance
In this task, you start deploying a new Azure SQL Server instance from within the Azure 

Portal, allowing you to migrate a database to it in the next task.

	 1.	 From within the Azure Portal “Search resources, services, and 
docs (G+/),” enter “SQL servers.” From the list of results, select 

SQL servers.
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2.	� Click “Create a new SQL Server” or click the “+Add” button 

in the top menu. This launches the Create SQL Database 

Server deployment blade.

	 3.	 Complete the different deployment settings as follows:

Basics tab:

–– Server name: [suffix]sqlazure[date], for example, pdtsqla-
zure0508 (capitals are not allowed)

–– Server admin login: labadmin

–– Password: L@BadminPa55w.rd

–– Confirm password: L@BadminPa55w.rd

–– Subscription: Your Azure subscription

–– Resource group: Create New/[SUFFIX]-SQLAzureRG

–– Location: Same Azure location as where you deployed the WebVM 
and SQLVM
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Note A lthough we define the same server admin credentials as the SQLVM SQL 
Server instance, these can be completely different in reality. We decide to define 
it this way for ease of the lab scenario. Same goes for the SQL Azure resource 
location, which can be any of the available Azure regions worldwide, irrelevant 
from where your SQL Server virtual machine is running today.
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Networking tab

–– Allow Azure services and resources to access this server:  
switch to “Yes.”

–– We won’t use the Additional settings tab for now.

	 4.	 Confirm the creation of the Azure SQL Server by clicking the 
“Review + create” button.

	 5.	 Validate the deployment summary, and confirm by clicking 
Create.
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	 6.	 Wait for the deployment to complete.

	 7.	 Once the Azure SQL Server has been deployed successfully, we 

can create a new database, by clicking the “+ Create database” 

button from the top menu. From here, we will define two settings, 

the database name and the database size:

–– Database name: [suffix]sqlazuredb

–– Compute + storage: Standard S0, 10DTUs, 250 GB storage
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	 8.	 To modify the Compute + storage settings, click “Configure 
database.”
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	 9.	 Select “Looking for basic, standard, premium?”
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	 10.	 Define 10 (S0) for DTUs, and keep the Data max size to 250 GB 

(know the sample database is about 50 Mb in size, but data size 

isn’t really impacting cost within the same allocated DTU size).

	 11.	 Click “Next: Networking”; notice you can’t make any changes 

to the firewall or networking settings here. We will make the 

necessary changes once the database has been created.

	 12.	 Click “Next: Advanced Settings”; accept the default settings as is.
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	 13.	 Confirm the creation of the database by clicking the “Review + 
create” button. Validate the configuration settings, and confirm 

by clicking “Create.”

	 14.	 Wait for the creation to complete. Once completed, click the 

“Go to resource” button, which redirects you to the SQL Azure 

database blade.

	 15.	 Here, we will modify the firewall settings, to allow the WebVM 

to connect to the Azure SQL Server database later on. Click “Set 
server firewall”.
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	 16.	 Under Rule name, Start IP, and End IP, enter the following 

parameters:

–– Rule name: allow_webVM.

–– Start IP: Enter the public IP address of the WebVM virtual 
machine.

–– End IP: Enter the public IP address of the WebVM virtual 
machine.

Note T he reason we have the WebVM IP address here is because we will run the 
SQL database migration from this server.

	 17.	 Save your settings.

This completes the first task, in which you deployed an Azure SQL Server instance 

and a new database. You also configured the necessary firewall settings to allow 

communication between the WebVM virtual machine and the Azure SQL Server.

�Task 2: Performing a SQL database migration from a SQL 
virtual machine to SQL Azure, using SQL Data Migration 
Assistant
In this task, you perform a SQL database migration from within a SQL virtual machine 

to SQL Azure. This approach is known as a lift and shift database migration, since no 

structure or data will be changed during the actual migration. Continuing on the path of 

the Azure migration tools available, you will use the Azure Data Migration Assistant you 

used earlier in the assessment phase to perform the actual migration.
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	 1.	 Open an RDP session to the WebVM virtual machine (using the 

same steps as described in the previous lab).

	 2.	 Once you are logged on to the WebVM RDP session, launch Data 
Migration Assistant (from a shortcut on the desktop or Start 

menu).

	 3.	 Click “+”, to create a new project.

	 4.	 Provide the following parameters:

–– Project type: Migration

–– Project name: SQLMig

–– Source server: SQL Server

–– Target server: Azure SQL Database

–– Migration scope: Schema and data
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	 5.	 Click the Create button to start this project.

	 6.	 This opens the SQL migration dashboard; in Step 1, complete 

the following parameters to connect to the source server:

–– Server name: sqlvm

–– Authentication type: Windows Authentication

–– Encrypt connection: Yes

–– Trust server certificate: Yes
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	 7.	 This will detect the SimplCommerce SQL database running on 

the SQLVM. Since you already executed the assessment in the 

previous lab, deselect the option to assess database. Click Next to 

continue to the next step.

	 8.	 In Step 2, complete the following parameters:

–– Server name: SQL Azure server name ([suffix]sqlazure.data-

base.windows.net)

–– Authentication type: SQL Server Authentication
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–– Username: labadmin

–– Password: L@BadminPa55w.rd

–– Encrypt connection: Yes

–– Trust server certificate: Yes
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	 9.	 This detects the SQL Azure database instance you created earlier.

	 10.	 Click “Next” to continue.

	 11.	 This brings you to Step 3. By default, all tables are selected, which 

is ok for our scenario.
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	 12.	 Click the “Generate SQL Script” button.

	 13.	 To run the actual migration, starting with the database schema, 

click “Deploy schema.”
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	 14.	 Wait for this step to complete successfully. This should take only a 

few minutes.

	 15.	 Lastly, click the “Migrate Data” button to start the actual 

database content migration. This will first show a list of tables; 

make sure all tables are selected here to not miss any data.
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	 16.	 And confirm, by clicking the Start data migration button.

	 17.	 Wait for this process to complete successfully; this should only 

take a few minutes, given the rather small-sized sample database.
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	 18.	 Once complete, close the Data Migration Assistant, without 

saving the changes.

	 19.	 Return to the Azure Portal, and browse to the SQL Azure 
database that just got migrated. From the SQL database blade, 

select “Query editor (preview).”

	 20.	 Enter the SQL Azure administrative credentials you defined 

earlier (default = labadmin and L@BadminPa55w.rd).
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	 21.	 You are prompted with another security warning; although you 

are connecting from the browser, the SQL server and database 

connection is “seen” as a SQL connection (port 1433) and not an 

HTTPS (port 443) connection. Therefore, you need to add your 
client IP to the list of firewall exceptions, similar to what you did 

for the WebVM.

	 22.	 Click “Set server firewall” [suffixsqlazure].
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	 23.	 Click “+ Add client IP,” which automatically detects your own 

client public IP address (JumpVM or your own Internet public IP 

address if running this from your own machine).

	 24.	 The Rule base got updated with your ClientIPAddress rule; save 

the changes.

	 25.	 From the Azure Portal breadcrumbs link, select the SQL Azure 
database.
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	 26.	 This brings you back to the SQL Azure database connection blade. 

Click OK to set up the connection. This is successful this time.

	 27.	 Click the “>” sign left to Tables, to open the list of tables in the 

database.
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	 28.	 From the list of tables, select dbo.Catalog_Product. Click the 
ellipsis (the three dots) next to it, to open the context menu. 

Here, click “Select Top 1000 Rows.” This adds a new query2 

item and runs it. The following shows the actual content of the 

products table more.
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	 29.	 This confirms the SQL Azure database is running as expected and 

confirms a successful migration once more.

�Task 3 (Optional): Using SQL Server Management Studio 
to migrate from SQLVM to a SQL Azure instance

	 1.	 If your DBA team is familiar with SQL Server Management Studio, 

know they can keep using this tool to perform the actual SQL 

database migration as well. To use this method, open an RDP 
session to the WebVM (labadmin and L@BadminPa55w.rd).
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	 2.	 Next, from within the RDP session of the WebVM, open a second 

RDP session to the SQLVM machine (remember, the SQLVM has 

no public IP address, not making it reachable from the outside) by 

running mstsc.exe from the Start menu.

	 3.	 As server name, type “SQLVM”. (Since both virtual machines are 

in the same Azure Virtual Network and subnet, the server name 

resolution works.). Click Connect.

	 4.	 Provide the local admin credentials of the SQLVM virtual 

machine:

–– labadmin

–– L@BadminPa55w.rd

And confirm with OK.

	 5.	 Once you are logged on to the SQL Server virtual machine 

(notice the SQL Getting Started shortcut on the desktop), click 

the Start button. Start typing “18”; this will resolve several 

management tools available on the server. Notice Microsoft SQL 
Server Management Studio 18.
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	 6.	 Select it to start the SQL Server Management Studio 18 console.

	 7.	 Once opened, you are asked for server connection information. 

Provide the following settings:

–– Server name: SQL Azure server name ([suffix]sqlazure<date>.
database.windows.net

–– Authentication: SQL Server Authentication

–– Login: labadmin

–– Password: L@BadminPa55w.rd
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Note T he reason this connection succeeds from an “internal” SQLVM that is 
not internet-facing is because we set the “Allow Azure services and resources to 
access this server” on SQL Azure level during the initial deployment. In a real-life 
scenario, you would need to configure the SQL Azure firewall and virtual network 
settings to allow hybrid connectivity between your on-premises infrastructure and 
SQL Azure, integrating with Site to Site VPN or ExpressRoute Networking.
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Click Connect to log on to this SQL Server instance.

	 8.	 In order to have a connection to the SQLVM database instance, 

we need to add another connection. From the SQL Server 

Management Studio console, click File ➤ Connect Object 
Explorer. In the Connect to server popup that appears, this time 

provide the server credentials from the SQLVM:

–– Server name: sqlvm

–– Authentication: Windows Authentication
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	 9.	 Click the Connect button. (If you get an unsuccessful connection 

error because of certificate chain not trusted, click the Options 

button and select to Trust Certificate.)

	 10.	 The Object Explorer shows a successful connection to both 

databases now. If you open the Databases level, you should see 

the SimplCommerce database.
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	 11.	 The next step is running the actual migration of the database. 

Therefore, select the SimplCommerce database on the SQLVM, 

right-click it, select Tasks, and select Deploy Database to 
Microsoft SQL Azure Database.

	 12.	 Click the Next button when you see the Introduction step 

showing up.
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	 13.	 In the Deployment Settings, provide the Server connection by 

clicking the Connect button. Provide the following details here:

–– Server connection: <your SQL Server in Azure>[suffix]
sqlazure<date>.database.windows.net

–– SQL Authentication (+provide credentials labadmin and  
L@BadminPa55w.rd)

–– New database name: SimplCommerce

–– Edition of Microsoft SQL Database: Basic

–– Max DB size: 2 GB

–– Service Objective: Basic
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	 14.	 Read through the settings in the summary step. Click the Finish 

button to start the actual move process.
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	 15.	 Wait for this process to complete – this should only take a few 

minutes.

	 16.	 Once completed, close the migration window.

	 17.	 This completes the task of migrating a SQL Server database to SQL 

Azure using SQL Server Management Studio.

�Task 4: Defining a hybrid connection from a WebVM 
to an Azure SQL database

	 1.	 To complete our hybrid cloud migration, we will now update 

the Connection strings settings in the appsettings.json file of our 

WebVM web application. This information can be retrieved from 

the SQL database settings in the Azure Portal. From within the 
SQL database detailed blade, browse to Connection strings 

under the Settings section.
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	 2.	 Leave this information on screen, or copy it into a temp text file, 

as you will need to copy parts of the ADO.NET connection string 

information into the web server’s web.config file.

	 3.	 Go back to the WebVM virtual machine Remote Desktop session 

(or open it again when you already closed the WebVM RDP 

session).

	 4.	 Browse to the IIS web server folder that has the web  

application content:

c:\inetpub\wwwroot\

Open the file appsettings.json with Notepad.
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	 5.	 Go to the section that starts with “ConnectionStrings”.

	 6.	 Replace the following settings with the parameters from the 

connection string information in the Azure Portal:

–– Server=tcp:sqlvm=>: Change the sqlvm to <Azure SQL server 

name>, nopsqlus.database.windows.net in our example.

–– Uid=sa =>: Change the sa account to labadmin.

Save the changes to the appsettings.json file. 
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	 7.	 From the Start screen on the WebVM, open a command 
prompt, by typing “CMD”.

	 8.	 In the command prompt, run the following command, to restart 

the IIS web server service:

iisreset /noforce

	 9.	 To prove that the web application is now connected to the Azure 

SQL database, let’s shut down the SQLVM. From the Azure 

Portal, navigate to Virtual machines, and click the SQLVM virtual 

machine.

	 10.	 From the SQLVM detailed blade, click the Stop button in the top 

menu. Wait for the notification message, telling you the VM has 

shut down.
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	 11.	 To test if the web application is now connected to the Azure 

SQL database, browse to the website from within the WebVM’s 

browser, connecting to localhost.

	 12.	 The website should load successfully and show you the product 

catalog list.
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	 13.	 If you receive an error message in the browser, similar to the 

following screenshot, it means there is something wrong with 

the SQL database connection. Verify your settings again in the 

appsettings.json file, and run IISreset again from the command 

prompt.

	 14.	 This completes this lab.

�Summary
In this lab, you learned how to deploy an Azure SQL Server resource, as well as how 

to migrate a SQL database using Azure SQL Data Migration Assistant and/or the SQL 

Server Management Studio 18. You updated the IIS web server appsettings.json file and 

validated the web application is now running in a hybrid setup.
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CHAPTER 6

Lab 4: Deploying an  
Azure Web App and 
Migrating from WebVM

�Lab 4: Deploying an Azure Web App and migrating 
from WebVM
�What You Will Learn
In this lab, you will publish your dotnetcore application source code to an Azure Web 

App, out of Visual Studio 2019, sometimes described as “right-click publish.”

In a second task, you will continue on the path of the Azure App Service Migration 

Assistant, running the actual web application migration from within that tool to a 

different Azure Web App.

In a later lab exercise, you will deploy the same web application using DevOps 

concepts.

�Time Estimate
This lab is estimated to take 45 min in total.

�Prerequisites
Make sure you completed Labs 1, 2, and 3 before starting this exercise.

https://doi.org/10.1007/978-1-4842-6437-9_6#DOI
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�Scenario Diagram

 

�Task 1: Publish an ASP.NET project to Azure Web Apps 
from Within Visual Studio 2019

	 1.	 Log on to the lab jumpVM virtual machine (for your information, 

credentials labadmin and L@BadminPa55w.rd), or your own 

developer workstation, having Visual Studio 2019 with the latest 

updates running.

	 2.	 From the lab jumpVM, browse to the folder that holds 

the GitHub downloaded source files (default location = 

C:\2TierAzureMigration).

	 3.	 Here, open the subfolder “SimplCommerce31”; this folder 

contains all necessary coding files for the SimplCommerce 

webshop application we are using.
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Note T his folder contains more source files than what we need in this lab, but 
don’t delete those, as you will use some of those in the labs coming.

	 4.	 Open the file SimplCommerce.sln, which should open your 

Visual Studio 2019 development environment.

	 5.	 Under the SimplCommerce.WebHost solution, notice the 

appsettings.json file.
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	 6.	 Open this file in the Visual Studio editor.
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	 7.	 In order to make our webshop work, we need to update the 

database connection string from the current SQLite configuration 

to the SQL Azure database connection string.

	 8.	 From the Azure Portal, browse to the SQL Azure database you 

migrated earlier ([suffix]azuredb), and open its Connection 
strings settings.

	 9.	 Copy the ADO.NET connection string, and replace the 

DefaultConnection parameter in the appsettings.json file as 

shown in the following example.

Note T he formatting of the connection string might get “lost” when copying; 
easiest to bypass this issue is pasting it in Notepad first, before copy/pasting it 
directly into the VS editor.
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As a reference, this is what the connection string should look like 

in full (all needs to be on one single line in the JSON), based on 

my setup:

"DefaultConnection": "Server=tcp:simplcsqlpdt.database.

windows.net,1433;Initial Catalog= simplcommercedb;Persist 

Security Info=False;User ID=pdtadmin;Password=L@

BadminPa55w.rd;MultipleActiveResultSets=False;Encrypt=True;

TrustServerCertificate=False;Connection Timeout=30;"

Also make sure you replace the {yourpassword} string with the 

actual password as shown in the preceding example.

	 10.	 Save the changes made to the appsettings.json.

	 11.	 Let’s validate the webshop app is working fine on the 

development station, by starting it in Debug mode.

Note I f you are running this lab from within the JumpVM, you need to allow the 
public IP from this connection, connecting to the SQL Server instance in Azure. To 
do this, browse to the Azure SQL Server in the Azure Portal ➤ Security ➤ Firewall 
and virtual networks.
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	 12.	 Add a new rule, named “allow_jumpVM,” having the JumpVM’s 
public IP address in the Start IP and End IP fields.

	 13.	 Switch back to your Visual Studio environment, and run the 

application by pressing “F5” or clicking the “IIS Express” link in 

the top menu

	 14.	 This compiles the application, showing debug information in the 

Output window, similar to the following screenshot (this is just 

a capture from during the debug; it doesn’t need to be the exact 

same).
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	 15.	 After about 30 seconds, the webshop will show up, confirming the 

application compiled fine, as well as having connectivity to the 

Azure SQL database we migrated earlier.

Note  While off-topic for our lab scenarios, know this is a fully functional 
e-commerce application, allowing you to create new customers, place 
orders, update products, and so on if you want to extend the demo and also 
perform write operations to the database.
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	 16.	 This confirms that our web application is working fine. You can 

close the browser session, which will also end the Visual Studio 

debugging.

This completes the first task in which you loaded a Visual Studio project, updated 

packages, made changes to the appsettings.json file database Connection strings 

settings, and ran a debug job to validate the e-commerce application is running fine.

In the next task, you will publish the application to Azure Web Apps.

�Task 2: Publishing the source code to Azure Web Apps

	 1.	 From within Visual Studio Solution Explorer, select 

SimplCommerce.WebHost, right-click it, and select Publish….

	 2.	 This starts the web application Publish wizard. In the Where are 
you publishing today? step, select Azure.
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	 3.	 Click Next.
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	 4.	 In the Which Azure service would you like to use to host your 
application? step, select Azure App Service (Linux). This works 

because our application is based on .NET Core, which runs on 

both Windows and Linux.

	 5.	 This brings you to the Select existing or create a new Azure App 
Service step window.

	 6.	 Click “+ Create a new Azure App Service…,” which opens 

yet another popup window, in which you need to enter several 

details, related to the Azure Web App name, Azure region, and 

App Service plan.

Complete/validate the different parameters:

–– Name: Update the dynamically generated name with a more accurate 
one (e.g., [suffix]simplcommercefromvs2019).
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–– Subscription: Select your Azure subscription.

–– Resource group: Create a new resource group/[SUFFIX]
SimplwebAppRG.

–– Hosting Plan: Create a new Hosting Plan, specifying S1 and a 
close-by region.

Chapter 6  Lab 4: Deploying an Azure Web App and Migrating from WebVM 



121

	 7.	 Confirm by clicking Create. The necessary Azure resources are 

getting created, which should take only about a minute. After that, 

the newly created app service will be listed as selected target for 

the web app.
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	 8.	 Confirm the deployment by clicking “Finish.” This returns you 

to the Visual Studio 2019 Publish window, highlighting your web 

app as target for Web Deploy.
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	 9.	 Click “Publish” to get the source files pushed to Azure Web Apps, 

and you can follow this process from the Visual Studio Output 

window.
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	 10.	 Wait for the process to complete successfully. At the end, Visual 

Studio will open your default browser, where you can validate the 

web app is running successfully.

Note I  freaked out at first, since my web app was not loading correctly in the 
browser – at least not in Internet Explorer 11 (which seemed the default on the 
JumpVM still). The following default web app page was shown:
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This could also be an issue with the code compilation itself (although we validated 

that in Visual Studio prior to publishing to Azure); however, when using Microsoft Edge or 

Chrome (which both are preinstalled on the JumpVM), the site was running as expected:

 

This completes the task, in which you published the webshop source code to Azure 

Web Apps using the Visual Studio Publish wizard integration.

�Task 3: Migrating a web application from Azure App 
Service Migration Assistant

	 1.	 Start an RDP session to the WebVM you have running in Azure 

(labadmin and L@BadminPa55w.rd).

	 2.	 From the desktop, launch Azure App Service Migration 
Assistant. Since we used this tool for performing the web 

application assessment in a previous lab, it will remember some of 

those parameters.
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	 3.	 Select the detected Default Web Site, and click Next.

	 4.	 The tool will perform another assessment first; when complete, 

click Next. This is where you will launch and execute the actual 

web app migration, starting with authenticating to Azure.

	 5.	 Click “Copy Code & Open Browser,” and paste in this Device 

Code in the popup window. Next, log on to Azure with your Azure 

admin credentials in the appearing popup. After a successful 

authentication, you are prompted to close your browser session.
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	 6.	 Back in the Azure App Service Migration Assistant, you can 

immediately continue the migration process. The next step is Azure 
Migrate Hub, allowing you to add this project to Azure Migrate.

	 7.	 You can skip this step for now, which brings you to the Azure 
Options window. Here, you need to provide the necessary 

parameters to get the web app deployed and configured:

–– Resource Group: Create a new resource group (the Migration 

Assistant will publish this application to a Windows-based web 

app, which cannot be mixed with the Linux-based web app service 

plan in the same resource group).

–– Destination Site Name: Provide a unique name for the web app.

–– Region: Your Azure region of choice.
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Note  The Migration Assistant automatically allocates a “Premium P1” App 
Service plan; if needed, this can be changed from the web app settings once the 
migration is complete.

	 8.	 In the database setup, choose “Skip database setup.”
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	 9.	 Confirm the settings by clicking the Migrate button.

	 10.	 This kicks off the actual Azure Web App deployment, followed 

by creating and copying the content. Wait a few minutes for this 

process to complete.
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	 11.	 Click “Go to your website,” which will open the newly deployed 

web app in the default browser.

	 12.	 This completes this lab.

�Summary
In this lab, you learned how to deploy a web application from source code in Visual 

Studio to Azure Web Apps, as well as by using the Azure App Service Migration Assistant.
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CHAPTER 7

Lab 5: Deploying Docker 
and Running Azure 
Container Workloads

�What You Will Learn
In this lab, we focus on deploying (a trial) edition of Docker Enterprise on Windows 

Server 2019, but using the LinuxKit rather than using Windows containers (just because 

we can and it is cool to showcase the mixed environment setup in my opinion). Starting 

with installing the Docker Enterprise Edition for Windows Server, you learn the basics 

of Docker commands using the Docker command-line interface. Next, you learn how 

to “Dockerize” the dotnetcore code that has been used in the former lab, using Visual 

Studio Code with Docker extensions.

In the next task, you learn about Azure Container Registry (ACR) and how to publish 

your new Docker container in there, as well as using this as a source for Azure Container 

Instance (ACI) and running your web application. We will also touch on deploying 

and running Azure Web App for Containers, allowing for advanced operations on 

containerized workloads, compared to Azure Container Instance.

�Time Estimate
This lab is estimated to take 90 min.

https://doi.org/10.1007/978-1-4842-6437-9_7#DOI
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�Prerequisites
There are no dependencies on previous lab exercises to start and complete this specific 

lab, outside of going through Chapter 2 to grab the necessary source files.

�Scenario Diagram

 

�Tasks
Task 1: Installing Docker Enterprise Edition on Windows  

Server 2019

Task 2: Validating and running basic Docker commands and 

containers

Task 3: Integrating Docker extension in Visual Studio Code

Task 4: Deploying and operating Azure Container Registry

Task 5: Deploying and running Azure Container Instance

Task 6: Deploying and operating Azure Web App for Containers
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�Task 1: Installing Docker Enterprise Edition (trial) 
for Windows Server 2019 on the lab jumpVM

	 1.	 If not logged on anymore to the lab jumpVM, open an RDP 

session to this virtual machine, using labadmin and  

L@BadminPa55w.rd as credentials.

	 2.	 From the Start menu, launch PowerShell with Run as 
administrator permissions.

	 3.	 Run the following cmdlet:

Install-WindowsFeature -Name Hyper-V -IncludeManagement 

Tools –Restart

	 4.	 Status information will be shown.
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	 5.	 After which the installation starts.

	 6.	 Once the installation is complete, your machine will restart 
(required!); wait for it to reboot, and log on using RDP again, 

reopening the PowerShell console (with Run as administrator 
permissions).

	 7.	 Next, we will install the Docker Enterprise Edition using the 

PowerShell module “DockerMSFTProvider,” using the following 

cmdlet:

Install-module “DockerMSFTProvider" –Force
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	 8.	 This is followed by an update-cmdlet to make sure we have the 

latest bits:

update-module "DockerMSFTProvider"

	 9.	 Next, we will trigger the actual Docker Enterprise package 

installation, executing the following cmdlet:

Install-package Docker -ProviderName 

"DockerMSFTProvider" -Update –Force

	 10.	 Once the installation of the package is complete, we also need to 

make sure we install the Windows Feature Containers, informing 

the host it will run as a container host, by running the following 
cmdlet:

Install-WindowsFeature Containers
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	 11.	 This is about it from a Windows Server and module perspective. 

However, we need to go through a few more steps to “enable” 

the Linux/Linux Containers on Windows – LCOW, starting 

with creating a config JSON file for the experimental aspect of 

LCOW.

Run the following cmdlet (this is on one line, but wrapped 
because of the layout):

Set-Content -Value "`{`"experimental`":true`}" -Path C:\

ProgramData\docker\config\daemon.json

Note I f you can’t complete this step successfully, verify if you have “Show 
Hidden items” enabled in your Windows Explorer.

 

	 12.	 This is followed by restarting the Docker service, using restart-
service Docker.

	 13.	 Confirm the Docker engine is up and running, by executing

Docker version

	 14.	 As well, execute

Docker info
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	 15.	 The Linux Containers on Windows expects a specific folder to 

run in, so we need to create this folder first; easiest is using  

mkdir <path>:

mkdir "C:\Program Files\Linux Containers"
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	 16.	 This is followed by downloading the “release” version of the 

kernel, by launching the following cmdlet:

curl -OutFile release.zip https://github.com/linuxkit/

lcow/releases/download/v4.14.35-v0.3.9/release.zip

	 17.	 Wait for the download to complete; after which, we need to 

expand the archive file, running the following cmdlet:

Expand-Archive -DestinationPath . .\release.zip
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	 18.	 This completes the installation of the LCOW component; I’m 

pretty sure this process will become more straightforward in later 

builds of Windows Server 2019, although it is actually not too hard 

already.

This completes the first task, in which you installed Docker Enterprise Edition on 

Windows Server 2019, using the Linux Containers on Windows (LCOW) Kit. In the 

next task, you learn several Docker commands for managing and running container 

workloads.

�Task 2: Validating and running basic Docker 
commands and containers

	 1.	 Let’s try and run a test Linux container, by executing the 
following command:

docker run -it ubuntu
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	 2.	 Since we don’t have the image on our local machine yet, it needs to 

be downloaded first; the Docker engine relies on the Docker Hub, a 

public (and private) repository of images to pull the image from.

	 3.	 Once the download is complete, Docker will “start up” the 
Ubuntu image and run it. This is expressed by giving us access 
to the Ubuntu system prompt (root@<containerID>#).

From here, we can perform some basic Linux commands, for 

example, “LS,” which means “list,” showing a list of folders.

	 4.	 Or running the command “TOP” will show the list of running 

system processes and their performance counters.
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	 5.	 To close the performance view, press Ctrl-C, which brings you 

back to the system prompt. If you want to shut down the container 

(= leaving the runtime), type “exit”.

Note I  received an error message here on-screen, informing me about “failed 
to shut down container.” This is presently listed as a known issue on the GitHub 
pages of the LCOW, although it is more of a bug in the status reporting, as the 
running container actually got shut down correctly.

	 6.	 Validate the running state of a container can be done by using the 

following Docker command:

Docker ps

	 7.	 This shows no running containers; however, if you add the -a 

parameter to this command, it shows us “history” information 

about containers that ran on this host.
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If you want to test with a few more Linux-based containers (e.g., 

Java, NGINX, Python, etc.) and several others that are available 

from hub.docker.com, feel free to do so.

Remember we have our own DotnetCore 3.1 sample container, 

based on the webshop application we used in the previous labs. 

To speed up the lab, as well as keeping the focus on running 

workloads on Azure, I am storing an up-to-date copy of the 

containerized application in my Docker Hub as well; so why not 

continue with this one from here, as well as for all remaining 

container-oriented lab exercises?

	 8.	 The SimplCommerce webshop container image in hub.docker.

com is pdetender/simplcdotnet31. So similar to the “docker run 

ubuntu” example earlier, you can execute this command:

docker run -it -p 5000:80 pdetender/simplcdotnet31

Here is some explanation for the parameters:

–– it: Runs the container in interactive mode, which means it will 
show output (if any) in the console window.

–– p 5000:80: This defines the container running on port 80, 
but mapping this to port 8000 in our local browser; this is 
handy when we have other applications or containers already 
running on port 80, as such avoiding any conflicts.
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	 9.	� Once the container is downloaded and running, open 
“localhost:5000” in your browser, which will show the “home 

page” of the SimplCommerce web application. Instead of 

expecting a full database like we used the Azure SQL earlier, this 

sample container image comes with its own built-in database 

engine. (If we want, we could update the container variables and 

actually point to an external database.)

Select “Phones” and click the “Do it!” button to confirm.

	 10.	 The webshop opens and shows devices available for buying.
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	 11.	 While this container instance is running, why not start  
another one?

	 12.	 Launch an additional instance of the PowerShell console (with 
Run as administrator permissions), and start a new container 
instance:

docker run -it -p 4000:80 pdetender/simplcdotnet31

	 13.	 This time it is running on port 4000. Since the image is already 
downloaded, the container instance will kick off immediately.
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	 14.	 Open your browser, and connect to localhost:4000, which will 

show the webshop home page, confirming this is a new instance, 

since it is asking again to select the product database we want to 

use this time.

	 15.	 This loads the full application once selected.
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	 16.	 Switch back to the PowerShell window (either of the open ones), 

and run docker images.

This shows a list of all current Docker images available on our 

machine. Note that besides the ubuntu and simplcdotnet31, I had 

a few additional ones, but you won’t necessarily have these.

	 17.	 Once more, validate the “running” state of your container 

instance from a “Docker perspective,” but initiating the following 

command:

docker container ls
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	 18.	 As you (should) still have the container instances running (port 

4000 and port 5000), you can take note of the (unique instance) 
container ID and reuse this in other Docker commands, like

docker inspect 82d44 (where these are the first few characters of 

the container ID).

This provides a lot of additional details about our running 
container instance:
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	 19.	 For example, consider “LogPath.”

	 20.	 This points to a log-JSON file, viewable from Windows Explorer, 

when browsing to the file location.

	 21.	 Open the log-JSON file, and notice the information stored in 

there is the same as what you saw earlier in the running container 

console (because you specified the “-it” parameter). Good to 

know this is not really required (although I personally prefer it, 

as it is a useful and easy mechanism to validate your container 

workload is running fine).
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This completes the second task, in which you learned several Docker commands, 

allowing you to run, validate, and troubleshoot containerized application instances. In 

the next task, I will show you another way to manage containers, using Visual Studio 

Code – Docker extensions.

�Task 3: Integrating Docker extension in Visual 
Studio Code

	 1.	 From the Start menu, launch “Visual Studio Code.”
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	 2.	 From the Extensions option, search for “Docker.”
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	 3.	 Click the “Install” button; while not (always) needed, I typically 

advise to restart Visual Studio Code after the installation, 

guaranteeing it loads successfully. This helped me tremendously 

in troubleshooting, or avoiding to needing to do that 😊.

	 4.	 Notice the Docker extension installed successfully, by clicking 
the Docker icon.

	 5.	 From the left menu, it immediately exposes some information 
about the Docker environment that is running on the Docker 
Host:

•	 Containers: Lists up the running/previously running 
containers on this host.

•	 Images: Lists up the container images.

•	 Registries: Private Docker-compatible registries, for example, 
Azure Container Registry.

	 6.	 Besides the information here on the left menu, the extension also 

comes with command palette options in the “View” menu.
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	 7.	 From “Command Palette,” start typing “docker,” showing a list 
of different commands available, similar to the ones you used 

in PowerShell earlier; but now you don’t (always 😊) have to 

remember them or know the correct syntax or parameters, but 

rather make use of this list.
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	 8.	 Remember the docker inspect command; you can run this now 

from the Docker extension menu.

	 9.	 This provides a similar log-JSON file, but directly published 

within Visual Studio Code.
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	 10.	 Or select “View Logs.”
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	 11.	 This exposes the logging information in a Visual Studio terminal 

window.

	 12.	 There are a lot of interesting actions available from the Docker 
extension, giving DevOps teams an easy and single tool to 
manage their application workloads, from source code to 
containers and everything in between.

This completes the third task in which I introduced you to the Docker extension 

in Visual Studio Code. As you know the basics of operating Docker and containerized 

workloads, let’s move on and reuse this knowledge on Azure.

�Task 4: Deploying and operating Azure Container 
Registry
As we have a successfully built Docker container out of the previous task, we can move 

on to the next step in the process, migrating this container to Azure, starting from 

pushing it into Azure Container Registry (ACR) and running it as an Azure Container 

Instance (ACI).

	 1.	 Log on to the Azure Portal, http://portal.azure.com, with your 

Azure admin credentials. From here, open Cloud Shell.
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	 2.	 Follow the configuration steps if this is the first time you launched 

Cloud Shell, by selecting your Azure subscription and clicking 

“Create storage.”

Once you are in the shell environment itself, make sure you select Bash.
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	 3.	 Execute the following Azure CLI commands, to create a new 
Azure resource group:

az group create --name [SUFFIX]-containersRG --location 

<Azure Region Name of choice>
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	 4.	 This is followed by another Azure CLI command to create Azure 
Container Registry:

az acr create --resource-group [Suffix]-containerRG  

 --name [SUFFIX]ACR --sku Basic --admin-enabled true

	 5.	 The next involves connecting to the Azure Container Registry we 

just created and pushing our Docker image into it. This relies on 

the following command:

az acr login --name [SUFFIX]ACR --resource-group 

[SUFFIX]-containerRG

	 6.	 This means we have to execute the remaining commands from 

our local lab jumpVM, instead of the Azure Cloud Shell. Since we 

preloaded the Azure CLI on this machine, we can immediately 

make use of it (FYI, if you need to install this on your local 

machine when not using the JumpVM, use the following link: 

https://docs.microsoft.com/en-us/cli/azure/install-

azure-cli-windows?view=azure-cli-latest).

	 7.	 To validate the Azure CLI is installed fine, open a new 
PowerShell window, and initiate the following command:

az
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	 8.	 This confirms Azure CLI 2.0 is running as expected. We can 

continue with our Azure Container Registry creation process. But 

first, we need to “authenticate” our session to Azure, by running 

the following command:

az login

	 9.	 This opens your Internet browser and prompts for your Azure 

admin credentials.
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	 10.	 After successful login, the following information is displayed:

	 11.	 You can close the Internet browser.

	 12.	 When you go back to the PowerShell window, it will show you 

the JSON output of your Azure subscription, related to this Azure 

admin user.
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Note I f you should have multiple Azure subscriptions linked to the same Azure 
admin credentials, run the following Azure CLI command to guarantee you are 
working in the correct subscription:

az account set --subscription "your subscription name here"

	 13.	 Let’s try to redo our Azure Container Registry process, by 

executing the following command:

az acr login --name [SUFFIX]ACR --resource-group 

[SUFFIX]-containerRG

	 14.	 You can also validate the Azure Container Registry from the 

Azure Portal.

	 15.	 And validate the details of the Azure Container Registry resource.
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�Task 5: Deploying and running Azure Container 
Instance

	 1.	 As we now have connectivity toward ACR, we can push our 

Docker image to it. There is however a dependency that the 

name of our Docker image needs to have the name of the Azure 

Container Registry in it. So we first need to update the Docker 

image tag for our Docker image, by executing the following 

command:

docker images (to get the image ID number)

docker tag bc2c [SUFFIX]ACR.azurecr.io/<nameyouwanttogive>

docker images (to validate the “new” image)
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Notice the image ID is identical, as technically, all we did was 
create a clone with a new name.

	 2.	 Execute the following command to upload this image to the Azure 

Container Registry:

docker push [SUFFIX]ACR.azurecr.io/<nameyouwanttogive>

	 3.	 Wait for this process to complete successfully; depending on 
Internet connection speed, this might take some time.
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	 4.	 From the Azure Portal ➤ All services ➤ Azure Container registries, 

select the ACR you created earlier.

	 5.	 Click the <yourcontainername> repository, which opens the 

specific details for this image, exposing its version (we used the 

default version tag “latest,” but this could also be dev, test, v1.1, 

v2.5, etc. in a real-life scenario).
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This completes this task, in which you created an Azure Container Registry (ACR), 

tagged a Docker container image, and uploaded this to Azure Container Registry 

repositories. In the next task, you will deploy this repository into a running state using 

Azure Container Instance (ACI).

�Task 5: Running an Azure Container Instance  
from a Docker image in Azure Container Registry

	 1.	 From the Azure Container Registry,  browse to Repositories, 

select your repository, and click “latest”; from here, click the … 

next to latest, and choose Run instance.

	 2.	 This opens the Create container instance blade. Complete the 
parameter fields using the following information:

•	 Container name: [suffix]simplcdotnet31 (or any other name you like)

•	 OS type: Linux
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•	 Subscription: Your Azure subscription

•	 Resource group: Select [SUFFIX]-containerRG as resource group

•	 Location: Same location as where you deployed ACR

Leave all other settings unchanged (one core, 1.5 GB memory, 

public IP address Yes, and port 80).
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	 3.	 Click OK to have the container instance created. Deployment 

initialization kicks off.

	 4.	 Follow the details by clicking the “Your deployment is underway” 

from the Notifications area.

	 5.	 Wait for the deployment process to complete successfully, which 

should typically be within a minute.
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	 6.	 Once the deployment is finished, click Go to resource; or open 

the Azure Container Instance in the portal (All services ➤ 

Container instances), and browse to the ACI “instance”  that just 

got created.

	 7.	 Copy the IP address for this Azure Container Instance, or directly 

browse to it from your Internet browser, which should load your 

application successfully.
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There’s the webshop again; similar to the “local” Docker container 

behavior, it opens the home page, asking for a product offering. 

While I’m not showing the outcome here, you already know how 

this works.

	 8.	 Back in the Azure Portal ➤ Azure Container instances blade, 

browse to Containers under Settings. Within the Events tab, 

there are more details about the running container itself, as well as 

providing a view on the process of pulling the image and running it.

	 9.	 Next, click the Logs tab,  showing you similar output from the 

log-JSON option you used earlier by executing “docker inspect” 

from the command line or selecting “Inspect” from the Docker 

extension in Visual Studio Code.
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	 10.	 Return to the Overview section of the Azure Container instances 

blade, and notice the action buttons on top, allowing you to start, 
restart, stop, or delete the container instance.

	 11.	 Nice to remember is that you don’t pay anything for a 
“stopped” container, so it could become handy to stop the 

container instance for now, saving a few bucks of your monthly 

Azure bill.
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	 12.	 Checking back from the instance Overview tab, notice the public 

IP address is also “released” from the running instance.

	 13.	 Start the container instance again, by clicking the Start button; 

wait a few seconds, and check on the updated settings. The 

container instance got a new public IP address.
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	 14.	 This is probably not something you want in a production 

environment, so let’s spin up a new container instance, this time 

starting from the “+ Create Resource,” and search for “container 
instance.”

	 15.	 Confirm the creation, by clicking the Create button.
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	 16.	 Provide the necessary settings, following these information 
guidelines:

•	 Subscription: Your Azure subscription

•	 Resource group: [SUFFIX]-ContainersRG

•	 Container name: Unique name for this container instance

•	 Region: Same Azure region as Azure Container Registry
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•	 Image source: Azure Container Registry

•	 Registry: <Your Azure Container Registry>

•	 Image: <Your Azure Container Repository>

•	 Image tag: latest

•	 OS type: Linux

•	 Size: 1 vcpu, 1.5 GiB memory

	 17.	 Where this is similar to the previous way of deploying an Azure 

Container Instance, only driven directly from Azure Container 

Registry repositories, we take it a small step further by going 

through some additional configuration parameters. Continue by 

clicking the Next: Networking button

	 18.	 From the Networking tab, notice the default networking type is 
“Public,” allowing a direct connection from the Internet to your 

running container instance. Switching this to “Private” allows you 

to define what Azure Virtual Network and subnet you want to 

deploy this container instance into.

To see this in action, select the jumpvmVNet.
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	 19.	 Although the subnet is automatically pulled up from the 

JumpVMVNet settings, we cannot use this subnet to mix 
container instances with virtual machines. This is also 

emphasized from this error message (if you try to deploy this):
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	 20.	 Instead, click “Manage subnet configuration,” which redirects 

you to the Azure VNet and Subnet settings. Here, add a subnet, by 

clicking the + Subnet button.
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	 21.	 From the Add subnet blade, provide the following parameters:

•	 Name: ACISubnet

•	 Address range: 10.1.1.0/24

Leave all other default settings, and confirm by clicking OK.
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	 22.	 Refresh the list of subnets; notice the ACISubnet will be in 

the list now. Next, click “Create container instance” from the 

breadcrumbs link in the portal, which brings you back to the 

Azure Container Instance creation wizard.

	 23.	 This time, select the ACISubnet in the Network and Subnet 

settings.

	 24.	 Move on to the next step in the ACI creation wizard, by clicking 
the Next:Advanced button. Here, one can specify when a 

container should restart, where the default is On failure, but 

could also be Always or Never.

In the Environment variables section, one could provide 

specific application variables, for example, to identify dev/test or 

production settings, database connection strings, and the like.
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	 25.	 That’s all we need to configure here; continue the deployment by 

clicking the “Review + create” button and confirming “Create” 
once more by clicking the button. This will kick off the creation 

of the second Azure Container Instance.

	 26.	 After about a minute, the private Azure Container Instance is 

ready; nothing is really different than before, besides that the IP 
address is now an internal IP range–based one; this would mean 

the containerized workload is reachable from within the JumpVM 

itself.
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	 27.	 (If not already) Open an RDP session to the JumpVM server, 

and once logged on, connect to the IP address of this Azure 

Container Instance from your browser.

	 28.	 Nice, achievement unlocked!

This completes this task, in which you learned about Azure Container Instance 
for public Internet-facing running workloads, as well as internal/private running 
ones.
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�Task 6: Deploying and operating Azure Web App 
for Containers
Another method to run containerized workloads in Azure Platform as a Service outside 

of Azure Container Instance is Azure Web App for Containers. Easily said, it gives you 

all (or most) of the Azure Web Apps features, but instead of publishing source code, you 

publish and run a Docker container.

Main differences compared to Azure Container Instance are that it allows for 

scalability, supports deployment slot swapping, and is linked to App Service plan 

consumption costs, instead of ACI running costs.

That’s what you will deploy and run in this task.

	 1.	 Start from the Azure Portal ➤ Create New Resource ➤  

Web App.

	 2.	 Click the Create button to open the Create Web App blade. 

Complete the required parameters as follows:

•	 App name: [suffix]contwebapp.azurewebsites.net

•	 - Resource group: [SUFFIX]-ContainerRG

•	 - OS: Linux

•	 - Publish: Docker Image

•	 - Region: Same region as Azure Container Registry
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	 3.	 You also need to define the App Service plan parameters.

	 4.	 For the Service plan parameter, click Create new.
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	 5.	 Complete the required parameters for the App Service plan as 

follows:

•	 App Service plan: [SUFFIX]contwebappPlan.

•	 Location: Same region as where you want to deploy the Azure 

Web App.

•	 Pricing tier: Select the Premium V2 P1v2 plan.

	 6.	 And confirm the plan with OK. Click Next:Docker to continue the 

configuration steps.

	 7.	 While we could use the same container from Azure Container 

Registry as in the previous task, let’s try something with Public 
Docker Hub this time, showing you running container instances 

on Azure (in any supported way) doesn’t require Azure Container 

Registry.

Complete the following settings and parameters:

–– Options: Single Container

–– Image Source: Docker Hub

–– Access Type: Public

–– Image and tag: pdetender/simplcdotnet31
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	 8.	 Confirm the creation by clicking the Review + create button.

	 9.	 Click the Create button to start the deployment of the Azure Web 

App for Containers.

	 10.	 Follow up on the deployment from the Notifications area.

	 11.	 Once deployed, browse to the [suffix]contwebapp Azure 
resource, which opens the detailed blade.

	 12.	 Click the URL which opens your default Internet browser. The 

containerized webshop workload should be up and running once 

more. 😊
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	 13.	 Go back to the Azure Portal, which still has your Azure Web App 

for Containers open; here, browse to Settings ➤ Container 
settings and look at the Logs section. This shows the different 

steps undergoing to get the container running.

	 14.	 For me, this is yet another benefit compared to Azure Container 

Instance, which is not giving you the same level of detail on what’s 

happening with the container during the creation of the web app 

itself, or at least not this easy.

This completes this task, in which you got introduced to Azure Web App for 

Containers.
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�Summary
In this lab, you learned about installing Docker Enterprise for Windows Server. 

Next, you learned the basics of running Linux-based Docker images and containers, 

followed by executing several Docker commands that are common when operating 

Docker images and containers, as well as how Visual Studio Code extension for Docker 

could help you as well.

In the following tasks, you pushed the Docker container to Azure Container Registry 

and deployed a container instance running the image. You also learned how to deploy 

Azure Web App for Containers, validating each process was working fine and offering a 

running e-commerce platform.
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CHAPTER 8

Lab 6: Deploying and  
Running Azure 
Kubernetes Service (AKS)

�What You Will Learn
In this lab, you will learn what it takes to deploy an Azure Kubernetes Service (AKS), 

create a Kubernetes YAML deploy file, and run the Docker-containerized webshop 

application within the AKS cluster.

�Time Estimate
This lab should take about 45 min to complete.

�Prerequisites
This lab continues on the deployments from Lab 5; make sure you successfully 

completed that lab before starting with this one.

https://doi.org/10.1007/978-1-4842-6437-9_8#DOI
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�Scenario Diagram

 

�Task 1: Deploying Azure Kubernetes Service using 
Azure CLI 2.0

Note  AKS deployment is working awesome from the Azure Portal, as well as 
from Azure CLI. To make it easy, let’s switch back to Azure Cloud Shell (Bash) and 
run the deployment from there.

	 1.	 From the Azure Portal, open Azure Cloud Shell and select Bash.

	 2.	 Run the following command to create a new Azure resource 

group:

az group create --name AKSNativeRG --location 

<yourregionofchoicehere>
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	 3.	 Next, run the following command to deploy the actual Azure 

Kubernetes Service resource:

az aks create --resource-group AKSNativeRG --name 

AKSCluster --node-count 2 --enable-addons  

monitoring --generate-ssh-keys

This command starts with creating the service principal, and 

moving on with the actual AKS deployment. Note this first part of 
the process (after creating the service principal) is not showing 
any output and looks like it’s hanging. But it is running fine in 
the background though. After a few minutes, the status changes 

to Running, which means the actual AKS resources are getting 

created now. You can validate this from the Azure Resource 
groups view in the portal, where a new RG got created, MC_<nam
eofAKSRG>_<nameofAKSCluster>_region.
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	 4.	 Open this resource group, where you can see the different Azure 

resources forming the Kubernetes cluster infrastructure getting 

created. (This might take away the magic of AKS a little bit, since 

technically it is a collection of traditional Azure IAAS components, 

like virtual machines, virtual network, load balancer, etc.)

	 5.	 After about 10 minutes, the AKS resource has been created, 

as you can notice from the Cloud Shell window, showing you 

detailed JSON output with all related parameters and settings of 

the created service.
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	 6.	 You can also validate this deployment from the Azure Portal, by 

browsing to your Kubernetes Service.
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	 7.	 Now that you have the Kubernetes cluster up and running, lets 

start with connecting to the Kubernetes environment and 
validating it is running ok, by performing the following steps:

az aks get-credentials -g AKSNativeRG -n AKSCluster

(Notice how you got introduced to the shorter naming convention 

of Azure CLI parameters, -g instead of - -resourcegroup or -n 

instead of - -name. 😉)

	 8.	 Next, validate the functioning by checking the nodes, using 

kubectl. kubectl (Kube Control) is the command-line 

management and operations tool for Kubernetes and already 

integrated in Cloud Shell; if you want to manage your AKS cluster 

from your local machine, you need to install this kubectl tool first, 

following the guidelines in https://kubernetes.io/docs/tasks/

tools/install-kubectl/:

kubectl get nodes
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	 9.	 As you can see here, we have two nodes running, identified with 

vmss000000 and vmss000001; this is the default name for Azure 

Virtual Machine scale sets. This immediately tells you AKS is ready 

for scale. I’ll guide you through how to do that in a later task.

This completes the task in which you deployed Azure Kubernetes Service using 

Azure Cloud Shell. In the next task, you learn how to integrate with Azure Container 

Registry, picking up your container image to have your containerized workload running 

in Kubernetes POD, which is the terminology for a running container in Kubernetes or a 

collection of containers.

�Task 2: Configuring RBAC for managing Azure 
Kubernetes Service and ACR integration
In the previous step, you deployed the AKS infrastructure and the AKS as a Service 

resource in Azure. Using the kubectl get nodes, you validated the underlying Kubernetes 

infrastructure is up and running.

Before we can have Kubernetes picking up Docker images from the Azure Container 

Registry you deployed earlier, we need to define Azure RBAC (Azure Role-Based Access 

Control) permissions for the Kubernetes resource to allow this. You need to create a 

service principal object in Azure Active Directory for this, which reflects an identity 

object for the AKS cluster.

	 1.	 Create the service principal as follows, from within your Azure 
Cloud Shell window:

az ad sp create-for-rbac --skip-assignment -n 

AKSClusterSP
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Since we need parts of this information later on, it might be good 

to copy this to a Notepad doc for easy retrieval.

	 2.	 This command creates an application ID and provides display 

name and tenant information that you’ll need later on in the 

Kubernetes YAML file (similar to the Dockerfile we used earlier, 

but for Kubernetes deployments).

	 3.	 Next item information we need is the full Azure resource ID for 
our Azure Container Registry. This information can be retrieved 

using the following command:

az acr show --name [SUFFIX]ACR --query "id" --output 

table

Copy this information into your Notepad doc as well, since you’ll 

need this information later on.

	 4.	 Next, assign the contributor role for the previously created 

“appid” service principal object to this Azure Container Registry 

resource, by executing the following command:

az role assignment create --assignee "appid" --scope 

"ACRid" --role contributor

This maps like this in my environment (replaced some characters 

for security reasons):

az role assignment create --assignee "ae0ad426-af05-

4a6a-0000-00000000" --scope "/subscriptions/0a407898-

c077-0000-0000-7142000000000/resourceGroups/ADS-

dockerRG/providers/Microsoft.ContainerRegistry/

registries/ADSACR" --role contributor
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	 5.	 We also will instruct kubectl (the Kubernetes cluster actually, by 

using kubectl) to use a secret, which will be used to get access to 

the Azure Container Registry, using the following command:

kubectl create secret docker-registry acr-auth --docker-

server <yourACR>.azurecr.io --docker-username 6956b3da-

0000000 (Appid here) --docker-password a90497d6-

69ea-000000 <app password here> --docker-email <your 

email address here>

Here is some explanation of the command information:

–– kubectl create secret: The command to create a secret.

–– docker-registry: Secret is of type “docker registry.”

–– acr-auth: A name you allocate to this secret.

–– docker-server: Azure Container Registry is a docker-compatible 

registry.

–– docker-username: Identifies the service principal object that has 

permissions.
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–– docker-password: Identifies the password of the service  

principal object.

–– docker-email: The email account, which could be a Docker 

account, but I’m using the Azure admin account email here.

With all the back-end information and the RBAC service principal and permissions 

in place, we can build our YAML deployment file for Kubernetes. Key information in 

here is the name of your Azure Container Registry, the container image filename that 

you want to push to the Kubernetes cluster, and what port the container should run on, 

as well as specifying what kubectl credentials you want to use.

This will be performed in the next task.

�Task 3: Running a Docker container image 
from Azure Container Registry in Azure  
Kubernetes Service

	 1.	 On the lab jumpVM, open Visual Studio Code. Browse to the 

source folder you used before, open the Kubernetes subfolder, 

and check for a file kubernetes.yml.

The content looks similar to this:
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	 2.	 Note several parameters that are important for a successful 

deployment:

- name: anothercontapp2 (this is just a random name you can 

decide on for the POD in AKS).

- replicas: 5 (this defines how many instances of this container 

image we want to run within the AKS cluster).

- image: pdtsimplacr… points to the Azure Container Registry 

and Docker images we pushed earlier (and the same one we ran 

in Azure Container Instance).

- port: 80 (specifies what port the app container should run on).

- imagepullSecrets name: The name of the RBAC contributor.

	 3.	 Replace the following sample parameters in this kubernetes.yml 

file with the actual values of your running environment:

- name: firstsample (replace this consistently for all “name” 
parameter settings)

- image: [suffix]acr.azurecr.io/simplcdotnet31:latest

(To find the correct image URL, go to the Azure Container Registry 

resource ➤ Repositories, select the pushed container image, 

and select latest.) You can grab the full URL from the Docker 

command option here.
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Note  A full-production YAML file for Kubernetes is probably looking more 
complex than this, but this is the baseline you need to see it in action.

	 4.	 The updated kubernetes.yml file should now look similar to 
this (for my environment):

Chapter 8  Lab 6: Deploying and Running Azure Kubernetes Service (AKS) 



200

	 5.	 Save the updated file.

	 6.	 As this file was edited on the local JumpVM, but we are running 

the AKS cluster operations from within Azure Cloud Shell, you 

need to upload this file first. From the Azure Cloud Shell window 

in the browser, select the “Upload/Download files” icon.

	 7.	 Browse to the kubernetes.yml file on the JumpVM disk. 

c:\2tierazuremigration\kubernetes\kubernetes.yml is the default 

location.

	 8.	 Wait for the upload to complete.

	 9.	 Running “dir” or “ls” in the Cloud Shell to get a list of items 

shows a successful upload.
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	 10.	 Next, run the deployment of this Kubernetes Service, by using 
the following command:

kubectl create -f Kubernetes.yml

	 11.	 As you can see, this throws an error message, related to the 

version of the deployment being used. This means we need to 

update our kubernetes.yml file once again. Instead of going back 

to the JumpVM Visual Studio Code and uploading the file again 

to Cloud Shell, let me introduce you to some “cloud magic” 😊, 

running VS Code directly from within Azure Cloud Shell.

	 12.	 Run the following command in Cloud Shell:

code Kubernetes.yml

This directly opens VS Code from within the shell itself! How nice!
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	 13.	 Update the parameter apiVersion to “apps/v1.”

	 14.	 Once edited, click the ellipsis (three dots) in the right-hand 

corner of Cloud Shell, and select Save (or press Ctrl-S).

	 15.	 Before we can initiate a new deployment, we need to 

make another update to this YAML file, that is, the name of 

the deployment. Although the earlier deployment failed, it 

is registered as a deployment in Kubernetes. Running this 

deployment again will throw another error, saying the name is 

already in use.

Therefore, replace the “firstsample” name to “secondsample” (in 

all locations).

The easiest way to do this is through Find/Replace; press Ctrl-H, 

which opens up the Find/Replace popup (similar to your local 

running instance of VS Code, but all done from within the Cloud 

Shell – yes, this is an almost full running instance in the browser!).
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	 16.	 Save the changes from the Find/Replace, and once more save the 
file.

	 17.	 Close the VS Code instance by pressing Ctrl-Q or selecting the 
ellipsis and choosing Close Editor.

	 18.	 Initiate a new deployment, by running kubectl create -f 
Kubernetes.yml again; notice this time, the deployment 

succeeds.

	 19.	 While this confirms a successful “deployment” task, it doesn’t 

mean the containerized workload is already up and running. But 

you can follow/validate this process, running some other kubectl 
commands:

kubectl get pods
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The reason why it shows five running PODs here is because we 

defined the replicas parameter in the YAML file (I’ll drill down on 

this high availability/scalability in Chapter 9).

Note  If you should see an error message here, it is most probably related to not 
having defined the ACR authentication correctly.

	 20.	 One can also check the actual container services, by running the 

following command

kubectl get services

or checking for more details for a specific running service:

kubectl get service --watch

	 21.	 Wait for the service to receive an external IP address, which 

would mean the POD is fully up and running in AKS. From 

here, you could open your browser and connect to the public IP 

address, revealing the e-commerce sample application!
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Note  This can take another few minutes before the app is actually fully loaded, 
no panic if it is not showing up immediately!

 

This confirms that our AKS service is fully operational, and the Docker container 

image that we pushed from the YAML file settings is also working correctly. Nice job!

This completes the lab.
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�Summary
In this lab, you learned how to deploy Azure Kubernetes Service (AKS) using Azure 

CLI, as well as how to manage and validate the deployment using kubectl Kubernetes 

command line. Next, you configured RBAC and ACR authentication for a service 

principal. This was followed by the creation of a kubernetes.yml deployment file, having 

a pointer to the Azure Container Registry repository image to use. After deploying 

this container image within the AKS cluster, you validated the functioning using the 

EXTERNAL-IP of the AKS service and checked the PODs.
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CHAPTER 9

Lab 7: Managing and 
Monitoring Azure 
Kubernetes Service (AKS)

�What You Will Learn
In this next lab of this workshop, we will focus on common operations related to 

AKS. This includes enabling the basics of container scalability within the platform, as 

well as configuring the new Azure built-in monitoring capabilities for these services, 

using Azure Monitor for Azure Kubernetes Service.

�Time Estimate
This lab shouldn’t take longer than 60 min.

Note  Depending on the subscription type you are using (e.g., Azure Trial, 
Azure Pass, etc.), you might be limited in the number of cores still available for 
performing the scale operations discussed in this task. If you are OK with it, you 
could delete the WebVM and SQLVM virtual machines to free up cores.

https://doi.org/10.1007/978-1-4842-6437-9_9#DOI
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�Task 1: Enabling container scalability in Azure 
Kubernetes Service (AKS)

	 1.	 AKS provides some nice integration in the Azure Portal, for 

example, on how to scale out your Kubernetes Service. From the 
Azure Portal, browse to your Azure Kubernetes Service. In the 

detailed blade, go to Settings ➤ Node pools.

	 2.	 Here, you can “scale” in two different ways, extending the 
amount of nodes in the existing pool or adding a new pool. You 

will configure both, starting with adding additional nodes to an 

already existing pool. To do this, click the number in the Node 
count column (2). This opens the “Scale” blade.
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	 3.	 Change the node count to “3,” leaving the Scale method as 
Manual. Save the changes by clicking Apply. Wait for the changes 

to apply, and validate by refreshing the blade.

	

	

	 4.	 From the Azure Portal, browse to the resource group holding the 

Azure resources for Azure Kubernetes Service, identified as MC_

AKSNativeRG_AKSCluster_<region>; here, select the “Virtual 
machine scale set”
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	 5.	 This redirects you to the individual scale set for the AKS Node 
Pool.

	

	 6.	 Notice how it identifies 3 out of 3 succeeded as Status; next, 

select Instances within the Settings pane.
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	 7.	 This shows the three nodes running. Clicking any of these would 

show more details about the running instance, but mainly from 

an Azure infrastructure perspective, not from a Kubernetes 

perspective. More on that later…

	 8.	 So now that you know how to extend the number of nodes in your 

cluster, let me show you the same, but using kubectl command 
line, again from Azure Cloud Shell (Bash):

az aks scale -g AKSNativeRG -n AKSCluster --node-count 4

4

Note  The command takes a couple of minutes to complete, without having 
impact on the already running PODs. The result is published in the JSON output.
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	 9.	 Let’s switch back to the Azure Portal view and “scale” the AKS 

environment by adding an additional node pool. Switch back 

to your AKS cluster, by searching for “Kubernetes” in the Search 

resources, services, and docs (G+/).

	 10.	 Select your cluster in the list of Kubernetes services.

	

	 11.	 From the AKS cluster details, select Node pools under Settings; 

here, click “Add node pool.”
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	 12.	 Complete the configuration of the new node pool, using the 
following parameters:

–– Node pool name: A name of your choice.

–– OS type: Linux.

–– Kubernetes version: Leave default (know this doesn’t need to 
be the same).

–– Node size: Choose a size/DS1 v2.

–– Node count: 1.
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	 13.	 You are back in the Node pools blade, where you can see the 

second node pool getting created (you might need a refresh to 

speed this up).

	

	 14.	 From here, you would technically repeat the same process as 

earlier if you want to extend the number of nodes in this second 

pool. To free up some resources, let’s delete this second node 
pool again.

	

	 15.	 Since adding pools is creating “separate” virtual machine scale 

set environments in Azure, it might not always be what you are 

looking for in terms of scaling. What if you want to run a larger 

amount of identical instances, but maxing out the capacity of 

your node pool? This is done using the kubernetes.YAML file (and 

something you actually already did). By scaling the actual number 

of PODs, using another update in the previously configured 
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kubernetes.yml file, you can identify how many identical 

instances you want to run.

This is done by running the following command:

kubectl scale --replicas=3 -f <path to yml file>

Which in this scenario scales down the number of replicas from 

five to three (remember we defined five replicas in the YAML file 

initially).

	 16.	 You can validate the operation using kubectl get PODs and  

kubectl get services --watch.

	 17.	 This completes the task on learning different scaling methods in 

AKS.

�Task 2: Monitoring Azure Kubernetes Service 
in Azure
Azure provides a nice integration (Insights) between standard Azure monitoring 

capabilities and the AKS services.
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	 1.	 From the Azure Portal, browse to Azure Kubernetes Service, 

and select your AKS service. From the Overview pane, you get 

a lot of important information about your AKS cluster setup, like 

Kubernetes version, amount of nodes/cores, and so on.
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	 2.	 Selecting the Capabilities pane next to Properties will open the 
detailed blade for this service. Here, select Azure Monitor.

	 3.	 You can reach the same by selecting Insights under the 

Monitoring section.
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	 4.	 From here, you can get a more detailed view on nodes, 
containers, and overall system processes and performance 
indicators.
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	 5.	 Click “Nodes” to get a more detailed view on amount and status 

of nodes.

	

	 6.	 Click “Containers” for a more detailed view of the running 

containers.
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	 7.	 From the list of containers, notice there are a lot of other “system 

process” containers, besides the containerized application 

(firstsample, secondsample) you published yourself. To get a 

clearer view on your own application containers, add it to the 

search field.

	

	 8.	 This filters the list of containers; by hovering over the POD 

names, you will notice that each “instance” of the secondsample 

replica is running in its own “POD,” where if you hover over the 
node names, part of them are running on VMSS000000, while 

some others are running on VMSS000001 (I couldn’t capture that 

little balloon popup in the screenshots).
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	 9.	 While this might (should 😊) be already quite impressive, 

especially if you are already familiar with Azure Monitor,  

knowing you can read out all this information from within the 

Azure Portal, know that Microsoft is working on an even more 

detailed view, currently in preview. But that shouldn’t stop me 

from showing you.

From the AKSCluster blade, browse to Kubernetes resources 

and select Workloads (preview).

	

	 10.	 This again shows a list of all currently running services 
(remember kubectl get services -watch?), but nicely integrated in 

the Azure Portal. Select “secondsample” as our service workload, 

showing additional details for this service.
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	 11.	 Next, click “YAML”; this exposes an actual YAML file configuration, 

almost similar to the one you used for the initial deployment.
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	 12.	 This could become handy for documenting your AKS cluster 

setup, including running nodes. Or why not make changes to 
the actual running state of your service? To show this, edit the 
number of replicas from five to two (line 14 in my example), 

and save the changes.

	

	 13.	 The YAML file is getting updated, highlighting the change, asking 
you to confirm the manifest changes and saving these once 
more.
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	 14.	 After saving the change and waiting for it to get applied, switch 
back to the Overview pane of this detailed view. See how the 

number of replicas of the “secondsample” has now gone down to 

only two.

	

	 15.	 The same goes for the Services and ingresses topic within the 

Kubernetes resources section; by selecting it, a list of currently 

running services will be shown, similar to the kubectl get services 

command you ran earlier.
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	 16.	 This time, it also shows the public IP address for each of the 

running services (that’s what the ingresses refer to, incoming 

traffic from the public Internet).

Note  These last few screens and options are still in preview, which means they 
might have changed by the time you go through this exercise yourself. It’s yet 
another nice improvement, trying to help Azure customers in managing the AKS 
environment, without requiring to be an expert on kubectl commands.

This concludes this part of the task, in which you learned how to manage your AKS 

environment from the Azure Portal.

�Task 3: Managing Kubernetes from Visual Studio 
Code
Besides the Azure built-in monitoring tools in the previous task, one can also manage 

the AKS cluster using Visual Studio Code.

	 1.	 Once Visual Studio Code is launched, from the menu, go to  

File ➤ Preferences ➤ Extensions. This shows a list of community 

and third-party vendor-provided extensions.
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	 2.	 In the Search Extensions Marketplace, type “kubernetes”.

	

	 3.	 Click Install and wait for the extension to get installed 

successfully. You will see a shortcut to it in the left menu sidebar. 

Click it. Since this extension requires kubectl, which is not 

preloaded on the VM, the extension fails.
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	 4.	 Click “Install dependencies” (only once is ok) and follow the 

progress from the terminal window.

	

	 5.	 Once the tools and dependencies have installed, refresh the 

Kubernetes extension by clicking its icon in the sidebar. This 

time no error messages show up anymore. From the Kubernetes 

section, click the ellipsis, and select Add Existing Cluster.
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	 6.	 You will need to go through a series of questions, to make sure the 

extension picks up the correct information.

	 7.	 Cluster type is Azure Kubernetes Service. Click Next >.

	

	 8.	 Select your Azure subscription then click Next >.
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	 9.	 Select AKSCluster as Kubernetes cluster. Click “Add this cluster >.”

	

	 10.	 The cluster got added successfully. From the Kubernetes pane, 

notice the AKSCluster resource is visible, allowing you to 

“manage” the cluster services and components.
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	 11.	 Click Deployments.

	 12.	 This shows the earlier pushed deployment for service 

“secondsample,” where we have two replicas running. Right-click 

any of the running PODs, to see an action menu.
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	 13.	 Feel free to perform an action against a running POD, for example, 

Delete Now.

This completes the lab exercise.

�Summary
In this lab, you learned the basic admin tasks about scaling Azure Kubernetes Service, 

using both the Azure Portal and kubectl command line. Next, you became familiar with 

the Azure Monitor capabilities of Kubernetes monitoring, as well as how the built-in 

standard Kubernetes dashboard can be used besides the Azure monitoring capabilities. 

Last, you deployed the Kubernetes extension in Visual Studio Code and performed some 

basic operations against the AKS cluster from there.
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CHAPTER 10

Lab 8: Deploying Azure 
Workloads Using Azure 
DevOps

�What You Will Learn
In this next lab, you get introduced to Azure DevOps, Microsoft’s tooling which allows 

for CI/CD pipeline deployments of application workloads to Azure (as well as other 

platforms). Starting from creating our Azure DevOps organization and project, you kick 

off the process by importing the source code of our sample e-commerce application from 

the GitHub repo into Azure DevOps Repos and learn the basics of Git and branching. 

Next, you get introduced to creating a build pipeline using the Azure DevOps classic 

editor as well as the newer pipeline.yml approach. From here, you will also learn how to 

deploy the previously built Docker container and run this in Azure Container Instance, 

but deployed using Azure DevOps release pipelines. Lastly, you will deploy the Docker 

container to the AKS cluster you deployed earlier, again using Azure DevOps release 

pipelines.

�Time Estimate
This lab is estimated to take 90 min.

https://doi.org/10.1007/978-1-4842-6437-9_10#DOI
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�Prerequisites
This lab continues on the deployments from Labs 3, 4, 5, 6, and 7. Make sure you 

successfully completed those, before starting this lab.

�Scenario Diagram

 

�Task 1: Deploying an Azure DevOps organization

	 1.	 From the “Search for resources, services, and docs (G+/)” field, 

search for devops.
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	 2.	 Select Azure DevOps organizations.

 

	 3.	 From the Azure DevOps start screen, click “My Azure DevOps 
Organizations”; this redirects you to the dev.azure.com portal, 

where you need to provide some additional details about your 

user and organizational profile.
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	 4.	 Click Continue.
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	 5.	 Click Create new organization.
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	 6.	 Click Continue.

 

	 7.	 Provide a unique name for your Azure DevOps organization 
and what Azure region you want to use for hosting the projects. 
Confirm by clicking Continue.
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	 8.	 Wait for this process to complete, after which you are redirected 
to the Azure DevOps portal (dev.azure.com/<organizationname>, 
where you are asked to create a new project.
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	 9.	 Define a project name, and set visibility to private (which 
means that only users within your organization can get access 
to it). Confirm by clicking the “+ Create project” button; your 

Azure DevOps “Workspace” gets created.

 

This completes the task, in which you deployed Azure DevOps and configured an 

Azure DevOps organization. In the next task, you will start using Azure DevOps Repos as 

a source control/version control mechanism.
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�Task 2: Introduction to source control with Azure 
DevOps Repos
The starting point of many successful deployments is source code. This can be application 

source code like a dotnetcore web app, but could also be used for Azure templates, 

PowerShell scripts, or basically any other data source facing regular updates. A popular 

source control solution today is GitHub (www.github.com), which by itself is based on 

Git, a distributed source control/version control solution. While GitHub is very useful, it 

is mainly used for public and community-based source code publishing. But what if you 

want to keep your source code “internal”? Like within your DevOps projects themselves? 

That’s what Azure DevOps Repos offers: a Git-compatible source control service.

This task introduces you to the basics of source control, guiding you through cloning 

a public GitHub repo into Azure DevOps Repos, from where you will work with versioning 

and branching. These changes will be used later on for the build and release pipelines.

	 1.	 From the Azure DevOps portal, select Repos.
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	 2.	 This gives you several options to choose from, specifying how 
this repo will be used. Select “Clone in VS Code.”

 

	 3.	 Confirm to open this repo in VS Code from the popup box.

 

	 4.	 This opens VS Code, asking you a confirmation to open the URI 
link; confirm this by clicking “Open.”
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	 5.	 Once opened, you need to specify where VS Code needs to 
clone the Azure DevOps Repos folder. Browse to the local C 
drive, and create a new folder, named Repossource.

 

	 6.	 In order to be able to clone, you need to provide your Azure 
DevOps credentials.
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	 7.	 After which, VS Code will provide you a prompt, asking if you 
want to open this folder; select Open in New Window.

 

	 8.	 From here, let’s at some “source code,” by creating a new file, 
typing some text (e.g., Test file to initiate the repo), and save the 

file in the root of the Repossource folder; I called my example 
“init.md”, but this is not that important. It can be saved as text 
file as well, with a name of your choice.
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	 9.	 Since the Repossource folder is automatically “Git-enabled,” 
thanks to Azure DevOps Repos, we can make use of the source 
control extension as part of VS Code. Click the source control 
icon.
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	 10.	 Notice how it picked up the “init.md” as a change, waiting to 
be “pushed” back to Azure DevOps Repos. To do this, click the 
“Commit” button.
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	 11.	 It will ask you to provide a “message,” which typically refers to 
the updates done to the repository (e.g., init repo or anything).

 

	 12.	 This throws an error message.

 

	 13.	 What this refers at is that each “git commit” must be linked to an 

individual person, in order to trace back who made changes. This 

is done by setting “Git variables,” which you didn’t do yet. Click 
“Open Git Log,” which redirects you to the “Output” window 

of VS Code; for now, the relevant information is executing the 

following two commands from the “terminal”:

git config --global  user.email “your email address”

git config --global  user.name “your name”
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	 14.	 Once these variables are set, return to the source control view, 
and commit your changes again.

 

	 15.	 While the commit was done successfully, it doesn’t mean the 
file has been uploaded to Azure DevOps Repos yet; VS Code has 
a built-in “safety net” (as I call it) to not sync immediately, but 
rather waiting for you to trigger this automatically (this could 
be handy when you detect mistakes in your source control, 
allowing you to edit and commit the change again – all this 
happens locally, without impacting the actual Azure DevOps 
Repos). To force the sync, click the “sync changes icon.”
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	 16.	 After a few seconds, you can check back in the Azure DevOps 
Repos portal and see the new file you created showing up there.

 

	 17.	 From Repos, select “Commits”; this shows the trace of your 
previous commits, triggered from VS Code. Notice how it 
recognizes your “name,” as well as showing the “message” you 
provided.
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	 18.	 As you now know the sync is working, thanks to Git integration 
out of Azure DevOps Repos, we can “upload” the source folder 
we used earlier into this Repos. To do this, open your File 
Explorer, and browse to the 2tierAzureMigrate source folder. 
Select ONLY the SimplCommerce31 folder.

 

	 19.	 Copy this folder to the target directory “Repossource,” noticing 
there is already a subfolder, named after the Azure DevOps 
Project.
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	 20.	 The content should look like this now:

 

	 21.	 Once the copy operation is complete, switch back to VS Code, 
and open the source control extension. This has picked up all 
the changes, ready to be “committed.”
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	 22.	 Commit the changes, and provide a descriptive message.

 

	 23.	 Next, click the “sync changes” icon again, and wait for all files 
to get pushed into Azure DevOps Repos. After about a minute, 
this should be completed.
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This completes the task in which you learned about source control, based on Azure 

DevOps Repos. Given the integration with Git, it allows a clone to VS Code (among other 

development tools), providing DevOps engineers with the necessary integration to 

enable source control, commit changes, and keep source code in sync. In the following 

task, you will create a build pipeline, based on this source control repository.

�Task 3: Creating and deploying an Azure build 
pipeline for your application
While Azure DevOps gives you an end-to-end solution to manage your application 

development and deployment lifecycle, this lab focuses mainly on the Azure Pipelines 

service within.

	 1.	 Select “Pipelines,” and within, select “Pipelines” once more.

 

	 2.	 You are greeted to create your first pipeline.
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	 3.	 Click Create Pipeline. This launches the Pipeline wizard, 
starting with the source code location.

 

	 4.	 Select “Azure Repos Git,” followed by selecting the repository 
you created earlier.
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	 5.	 This brings you to the “Configure your pipeline” blade; based 
on the source code, it will offer you different selections. Since 
our application is a dotnetcore app, select ASP.NET Core.
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	 6.	 This results in an azure-pipelines.YML file, storing the actual 
configuration of the build pipeline.

 

	 7.	 While this file is already quite useful, we are going to make a 
few changes to the tasks, outside of the default configuration 
offered here. Scroll down to line 24, where you find the task 
“VSBuild@1”:

 

	 8.	 Replace the msbuildArgs line with the following update:

msbuildArgs: /p:DeployOnBuild=true /p:DeployDefault 

Target=WebPublish /p:WebPublishMethod=FileSystem 

/p:publishUrl="$(Agent.TempDirectory)\WebAppContent\\"

Note this should all be on a single line.

	 9.	 The new layout should be similar to this:
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	 10.	 Also verify the indention of the line is at the same level as 
solutions, platform, and configuration; these actually define 
the parameters (input) for this task. If the indention is wrong, 
these will not be recognized however.

	 11.	 Next, below the VSBuild@1 task, add a new task, by inserting 
the following lines:

- task: ArchiveFiles@2

   displayName: Archive Files

   inputs:

     rootFolderOrFile: $(Agent.TempDirectory)\WebAppContent

     includeRootFolder: false

	 12.	 The file structure should look as in the following:

 

	 13.	 Validate the indention of “- task,” making sure it is in line with 
the level of the previous task, as well as for the displayName 

and inputs.

Last, paste in the following new task “PublishBuildArtifacts@1,” 
based on the following lines, at the end of the current file:

- task: PublishBuildArtifacts@1

  inputs:

    PathtoPublish: $(Build.ArtifactStagingDirectory)

    ArtifactName: drop

    publishLocation: Container
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	 14.	 The file structure should look like the following:

 

	 15.	 Click Save and run; accept the defaults and confirm once more.
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	 16.	 This creates your pipeline and initiates the build job against 
the Azure DevOps Agents.
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	 17.	 Click the job item itself, which opens the more detailed view 
of the running job, showing the different steps in the build 
process.

 

	 18.	 Wait for the process to complete. Notice there are several 
warnings visible during the VSBuild stage; these can be ignored 
for now.

 

	 19.	 After about 5–6 minutes, the job completes successfully.
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This completes the task in which you set up a build pipeline, 

based on application source code in Azure DevOps Repos. In the 

next task, we will continue the process, by creating and running a 

release pipeline, publishing the code to Azure.
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�Task 4: Building a release pipeline in Azure DevOps

	 1.	 From Azure DevOps ➤ Pipelines, select Releases.

 

	 2.	 Next, select New pipeline.
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	 3.	 This launches the New release pipeline creation wizard.

 

	 4.	 From the template list, select Azure App Service deployment. 

Provide a description for the Stage name, for example, Deploy_
to_webapp.

 

	 5.	 Close the Stage window.

	 6.	 The pipeline now looks like this:
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	 7.	 Before defining the actual deployment task, let’s add the artifact; 

this is the source package for the actual deployment, which you 

created during the previous build task. Click “Add an artifact.”
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	 8.	 Click the Source (build pipeline) drop-down icon, and select 
“LearningAzure,” which is the source build pipeline you created 

earlier. This will complete some additional parameters.
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	 9.	 Confirm by clicking “Add.” The updated pipeline looks like this:
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	 10.	 In the Stages field, select “1 job, 1 task”; this is where you will 

provide the settings of the Azure Web App environment you will 

use for the actual deployment.

 

	 11.	 Since it’s the first time we integrate Azure DevOps pipelines 

with Azure itself, you need to authorize this from the Azure 

subscription topic (since your Azure admin and Azure DevOps 

admin accounts are the same and have full permissions, this 

“just works”; in a production environment, you would configure 

a “Service ConnectionPoint” for this, using a service principal 

(remember you did something similar for RBAC in the AKS lab?).
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	 12.	 Click Authorize, and authenticate using your Azure admin 

credentials. You will notice the list of App Service names is empty. 

This makes sense, since we didn’t deploy the Azure Web App 
resource yet. While Azure Pipelines could do this from an ARM 

template or Azure PowerShell or CLI, let’s do it a bit more manual 

for now. (Think of the Ops team providing the Azure resources 

and the Dev team (= you) providing the source code for the web 

app…)

	 13.	 Switch to the Azure Portal, and create a new resource “web 
app,” using the following parameters for the deployment:

–– Resource Group: Create New/FromAzureDevopsRG

–– Name: Unique name of your choice

–– Publish: Code

–– Runtime stack: .NET Core 3.1
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•	 Operating System: Windows

•	 Region: Region of choice
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	 14.	 Accept the defaults for the App Service plan.

 

	 15.	 Confirm the creation by clicking Review + create and once 
more Create. Wait for the deployment to complete.

 

	 16.	 The baseline is ready, so let’s switch back to Azure DevOps 
Pipelines and complete the following settings:

–– App type: Web App on Windows

–– App service name” <name of the web app you just created>
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	 17.	 Next, click the task “Deploy Azure App Service.”

 

	 18.	 Validate the setting “Package or folder” looks similar to this:
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This refers to the webdeploy package you created out of the 
build pipeline.

	 19.	 When done, click Save in the top menu of your Azure Pipelines 

project, and click OK for the popup showing the folder (“\”) where 

to store this information, followed by Create release.

 

	 20.	 Accept the default settings.
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	 21.	 And confirm the creation.
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	 22.	 Click “Release-X” in the confirmation bar.
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	 23.	 Click the “In progress” status, and wait for this process to 
initialize.
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	 24.	 This shows the detailed progress for each and every step in the 
process; wait for the task to complete.

 

	 25.	 The release pipeline shows this Succeeded status as well.

 

	 26.	 From the Azure Portal, browse to the Azure Web App you selected 

in the release pipeline as target, and validate it is running as 

expected.
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	 27.	 If you should receive the following web page instead of 
the webshop itself, it typically means there is no database 
connectivity; validate your SQL Azure database is present, as 
well as checking if you (still) have the database connection 
string in the appsettings.json file in the Azure DevOps Repos 
SimplCommerce31\src\Simplcommerce.webhost\ folder.
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	 28.	 If you receive the following web page instead of the webshop 
itself or the HTTP Error 500.30, it means you were a bit too 
fast 😊; waiting for a few seconds and refreshing the website 
typically fixes this. You could also try to stop and start the web 
app again to force the publishing.

 

This completes the task in which you created a release pipeline, based on a previous 

build pipeline configuration, allowing you to publish an Azure Web App.

�Task 5: Creating and pushing a Docker container 
to ACR
In one of the previous labs, you learned the basics of Docker commands and how 

to push an existing Docker Hub container image to Azure Container Registry. Most 

probably at that time, you were wondering how to create a Docker container yourself, 

right? Since this felt a bit more “DevOps” in character, I decided to keep it for the Azure 
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DevOps module. So here we are, where I will guide you through creating a Dockerized 

container image, based on the webshop source code, and pushing this container image 

to Azure Container Registry, all done by Azure DevOps.

	 1.	 Let us start with creating a new Azure DevOps Project (this is not really 

required out of Azure DevOps itself, but just feels more organized to 

me), by clicking “Azure DevOps” in the upper-left corner in the 
Azure DevOps portal and clicking “+ New project.”

 

	 2.	 Provide a project name, keep visibility to private, and confirm by 

clicking Create.
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	 3.	 Once the project got created, select Repos, where you will “import 

a repository.”

 

	 4.	 Provide the following URL:

https://github.com/simplcommerce/simplcommerce.git (know 

this repo is managed by SimplCommerce itself, not by me; since 

it is getting continuously updated, I thought it was more safe to 

provide this one, to make sure the container build steps keep 

working)
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	 5.	 The import process starts.

 

	 6.	 Once the import succeeded, the Repos structure looks like this:
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	 7.	 Next, create a new (build) pipeline, by selecting Pipelines ➤ 
Create Pipeline.
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	 8.	 This launches the Create Pipeline wizard. In the “Where is your 
code?” step, select Azure Repos Git.
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	 9.	 Click Next. Select “SimplCommerce” as the repo to use.

 

Chapter 10  Lab 8: Deploying Azure Workloads Using Azure DevOps



286

	 10.	 This builds up an azure-pipelines.yml file, looking similar to 
this one:

 

	 11.	 Notice it offers different jobs, for different Operating System Build 

Agents (Mac, Linux, Windows); this is because the application is 

developed in dotnetcore, which is supported to run on each of 

those platforms.

	 12.	 This creates the new job.

 

	 13.	 Select the job, which shows more details for the running job(s).

Chapter 10  Lab 8: Deploying Azure Workloads Using Azure DevOps



287

 

	 14.	 You could select any of the jobs to get even more details about 
the build process itself; since you already did that in earlier tasks, 

I’ll skip that for now.

	 15.	 Return to Azure DevOps Pipelines, and create yet another one. 

When you are asked where the source code is, select “Azure 
Repos Git.”
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	 16.	 Next, you need to select the repository to use. Here, select 
“SimplCommerce.”
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	 17.	 Next, in the Configure your pipeline step, select “Docker – Build 
and push an image to Azure Container Registry.”

 

	 18.	 Next, select your Azure subscription and confirm by clicking 
“Continue”; this will prompt you for your Azure admin 

credentials.
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	 19.	 Once authenticated, select your Azure Container 
Registry from the list, and update the container name to 
“devopssimpl[suffix].”

 

	 20.	 Click “Validate and Configure,” which produces an azure-
pipelines.yml file, looking like the following screenshot:
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	 21.	 Confirm by clicking “Save and run.”
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	 22.	 Provide a descriptive name in the Commit message field, and 

confirm by clicking Save and run again, which creates the 
pipeline.
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	 23.	 Click the “Build” job, to open more details about the job. Notice 
how each step in the Dockerfile gets processed.

 

	 24.	 If you follow along in the container build process, you will 
notice that all the way at the end how the name gets tagged to 
the container, followed by the Docker Push command for this 
container image.
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	 25.	 Validating this process from the Azure Portal itself shows the 
successful push as well.

 

This completes the task in which you learned how to containerize an application 

using Docker build pipelines.

�Task 6: Creating a release pipeline for Docker 
containers from ACR
Similar to the previous release pipeline from source code in GitHub to a published Azure 

Web App, we can use the same concept to create a release pipeline, based on a Docker 

container in Azure Container Registry. This is similar to the manual task you ran in Lab 4 

earlier.

	 1.	 From Azure DevOps, select Pipelines ➤ Releases ➤ New release 
pipeline.
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	 2.	 When the template window appears, close it, and select “Add 
an artifact” first.
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	 3.	 From the Add an artifact blade, click “5 more artifact types,” to 

extend the list of artifacts to choose from.
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	 4.	 Select “Azure Container Registry.”

 

	 5.	 Complete the parameters according to the existing resources in 

your Azure subscription, reusing the resources from previous lab 

exercises (Azure Container Registry, repository, etc.).
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	 6.	 Confirm the artifact selection, by clicking Add.

	 7.	 Your artifact will be completed.
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	 8.	 Next, click Stages ➤ Add a stage, and select Azure App Service 
deployment.
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	 9.	 Confirm with Apply; provide a descriptive name for the stage, 
for example, “Deploy to webapp for containers.”

 

	 10.	 Close the Stage popup, followed by selecting the “1 job, 1 task” 
item in the pipeline view.
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	 11.	 Provide the required parameter for your Azure subscription, 
and specify “Web App for Containers (Linux)” for App type.

 

	 12.	 Complete the additional parameters for Azure Container 
Registry and image. Note you have to provide these values 
yourself; they are not pulled from a list box like in the previous 
task when publishing the web app. These are the screenshots 
from the Azure Portal to help you in finding this information:
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	 13.	 The deployment parameters should look similar to my 
screenshot:
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	 14.	 Click “Save,” and confirm the popup as OK, followed by “Create 
release.”

 

	 15.	 Validate the settings for this new release pipeline.

 

	 16.	 And confirm the deployment by pushing the Create button. 
This creates Release-1.
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	 17.	 Click “Release-1” to open the detailed deployment blade 
(depending on how fast you do this, the state could be Queuing, 
Running, or Completed).

This kicks off the release creation; follow the different steps 

occurring, and wait for them to complete successfully.
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	 18.	 Once the task is complete, you can see its overall status from the 

Pipeline window.

 

	 19.	 Check back in Azure Web Apps if your app is running successfully, 

by connecting to the Azure Web App URL for this Azure resource.
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This completes the task in which you created a new Azure Pipelines release, 

deploying an Azure Web App for Containers, relying on a repository in Azure Container 

Registry.
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�Task 7: Creating an Azure DevOps pipeline to deploy 
an ACR container to Azure Kubernetes Service 
(AKS)
In this scenario, you will create yet another Azure release pipeline, this time pushing a 

container from ACR into the earlier deployed Azure Kubernetes Service cluster.

	 1.	 From Azure DevOps, select Pipelines ➤ Releases ➤ New release 
pipeline.

 

	 2.	 Close the appearing template window, and return to Artifacts; 
click “Add an artifact.”
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	 3.	 Repeat the steps from the previous task, selecting Azure 
Container Registry as source and selecting the ACR and 
container repository you want to use for this deployment.  

I show you my settings as illustration:
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	 4.	 Next, select “Add a stage,” and select the Deploy to a Kubernetes 
cluster” template.
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	 5.	 Confirm by clicking Apply; provide a descriptive name for the 
stage, for example, Deploy_to_AKS.

 

	 6.	 Close the Stage popup, which returns you to the Release 
Pipeline window. Click “1 job, 1 task” under Stages.
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	 7.	 Select “kubectl,” and provide the necessary settings and 

parameters of the AKS cluster you deployed in a previous lab, 

knowing you only need to provide the Kubernetes service 
connection name.
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	 8.	 To create this one, click “+ New” next to it, which opens the New 
service connection blade; your Azure subscription will get resolved, 
as well as asking you for your Azure credentials. After successful 
logon, you can complete the Kubernetes cluster information and 
namespace, similar to what it looks like in my setup:
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	 9.	 Click Save; the pipeline definition shows the Kubernetes 
service connection now. Since you already defined the 
namespace in the service connection settings, you can leave 
that field blank here.

 

	 10.	 Confirm the settings using Save and Release.

 

	 11.	 Click Create release from the pipeline confirmation window.
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	 12.	 The release is getting created.
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	 13.	 Click “Release-1,” to open the detailed view of the release task.
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	 14.	 This results in a successful job.

 

Note T he full deployment process is much much much more powerful and 
provides many more settings than we had here, but this is mainly to allow you to 
experience what a base deployment release pipeline can do and how to configure it.

This completes the task in which you created a new Azure release pipeline for a 

deployment of an ACR-stored repository to an existing Azure Kubernetes cluster.

�Summary
In this lab, you performed several tasks around Azure DevOps, starting from the initial 

creation of an Azure DevOps organization, followed by creating an Azure DevOps build 

pipeline, using a GitHub repository with an application’s source code. In the next task, 

you created a release pipeline, deploying the build from the previous task, publishing an 

Azure Web App.

The following tasks involved creating an Azure DevOps release pipeline to publish 

an Azure Container Registry repository image to Azure Container Instance, as well as to 

publish to Azure Kubernetes Service.

Congrats if you completed all labs with all tasks from all modules. You should 
now have a real good understanding of Azure and where it can help in your overall 
digital transformation. Reach out when having any questions or concerns or wanting 
to share overall feedback about the lab content used in this book (peter@pdtit.be or 
@pdtit on Twitter). Have a nice day!
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